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About This
Manual...

How to Use This Manual

This manual 15 erganized in encyclopedic form, with each chapter
covering a subject. It does assume soine basic knowledge of the HP
16500A and its user interface If you are unfamihar with the user
Interface, chapter 3 of this manual gives a brlef overview of its
operation

Chapter 1 gives a brief pictoral explanation on the process of writing a
pattern generator program, as well as the part played by each of the
menus

Chapters 4, 5, and 6 describe the functions In the three main menus of
the pattern generator Each mcludes pictoral index on the second page
of the chapter This pictoral Index names each of the fields in the
menu and gives the page or chapter number in this manual where you
will find a detaled explanation of its use

At the start of each major section in the chapters you'll find headings
that look like this

Menu: Format
Field: Clock $Selection (6)

Notice that below the bar there are two lines that say Menu and Field.
The Menu line tells you which menu the function is m. The Field line
tells you which field in the menu to touch to get to the function.
Directly after the Field line you'll see a number in parenthsis. Thig
number refers back to the pictoral index in chapter 4,5, or 6 The
number serves as a cross reference, allowsng you to look back at the
rmenu pictures and see what field 1s being discussed.  If you are unsure
cf the field being discussed in the text, turn to the pictoral index for the
meny isted, and look at the picture to see which numbered field is
esplaned In the example abave you would turn to the Fermat menu
index in chapter 4, and look up field 8, which is the Clock Selection
fleld If there is o number following the field name, it means that the
field may ke found in mare than one menu, such as the Print or Run
field



Exclusive

Remedies

Assistance

Certification

Safely

THE REMEDIES PROVIDED HEREIN ARE THE BUYER'S SOLE AND
EXCLUSIVE REMEDIES. HEWLETT-PACKARD SHALL NOT BE LIABLE
FOR ANY DIRECT, INDIRECT, SPECIAL INCIDENTAL, CR
CONSEQUENTIAL DAMAGES, WHETHER BASED ON CONTRACT,
TORT, OR ANY OTHER LEGAL THEQRY

Product maintenance agreements and other customer assistance
agreements are avaliable for Hewlett-Packard products

For any assistance, contact your nearest Hewlett-Packard Sales and
Service Office  Addresses are provided at the back of this manual

Hewlett-Packard Company certifies that this product met its published
specifications at the time of shipment from the factory
Hewlett-Packard further certifies that its calbration measurements are
traceable to the United States National Bureau of Standards, to the
extent allowed by the Bureau's calibration facility, and to the calibration
facilities of other International Standards Qrganization members

This product has been designed and tested according to International
Safety Requirements To ensure safe operation and to keep the
product safe, the information, cautions, and warnings in this manual
must be heeded
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Introduction

Welcome to the new generation of HP logic analyzers! The HP 185004
Legle Analysis System has been designed Lo make it easier to use than
any previous Hewlett-Packard logic analyzer. And, because of its
configurable architecture, it can easily be tallored to your speciflc loglc
design and debug needs,

The user interface of the HP 16500A was designed for the most
intuitive operation possible  The use of "pop-up” windows and color
graphics helps lead you through set ups and measurements without
having to memornize a lot of steps.

I you haven't already read “"How To Use This Manual™ at the front of
this book, please do so. It will give you some important information
about the structure of this manual and how to get the mest out of it,



1 What is the HP 16520A/16521A?

The HP 16520A/16521A Pattern Generator is a programmable, 50
Mhbit/s pattern generation medule that plugs into the HP 16500A Loglc
Analysis System The HP 16520A 15 a master card, and can support up
to four of the HP 16521A expansion cards.

The key features of the pattern generator are

. " e

50 Mhit/s data rate

12 NRZ data channels on each HP 165204 master card

48 NRZ data channels on each HP 16521A expansion card

Up to 4085 program steps

Three 20 MHz RAZ strobe channels on each HP 16520A master card
Lightweight, passive probes

Gives the HP 16500A Logic Analysis System up to 204 data
channels with one master card and four expansion cards installed
TTL or ECL output

External clack input

Up to four user-definable macros

External quakfier inputs

What is the HP 16520A/16521A2
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Pattern Generation The following dlagram lustrates the process of writing a pattern

Process generation program on the HP 165204/16521A Pattern Generator
cards it also shows the chapters in this manual that cover those
subjects

SET PATTERN GENERATOR
PROGRAM PARAME TERS

LABEL CHANNEL GROUFS = FORMAT MEMI
4SSIGN CHAWNELS TO LABELS "

SET CTAUT DATA RAFE CHAPTER 4
OFEFINE STROBES

DEFINE SPECTAL STMBOLS
SET CHANNEL POLARITY

S

WRITE FUNCTION MACROS (OPTIONAL )

NAME MALRON S) = I!IACF‘O LI‘?T MEHL
CEFINE PATTERNS & SEQUENCE CHAPTEP &

WRITE MAIN PATTERN GENERATION

PROGH U
SET MUMERICAL DIGPLAT BASE = LISTINHG MENU
EWTER PATTERNS, INSTRUCIIONS & SECUENCE CHAPTER 5

INCLUDING MACRCG NAMES
EQIT PROGFM 145 NEEDED]

)

RUN THE PRIIGRAM
oMZE = AtT MEMU
REPETITIVEL Y A
SINGLE-STER CHARTEP 7
i

What is the HP 16520A/16521A?
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The pattern generator menus are designed so that they share as many
operations as possible with the logic analyzer modules for the HP
16500A That means that once you've learned how te use the pattern
generator, learning the logic analyzer is made much simpler, and vice
versa

What is the HP 16520A/16521A7
1-3



What Cables and
Probes are
Inciuded?

Cables and Probes

The cables listed below are already connected to the instrument when
you receive it and exit via the rear panel of the instrument

Each HP 16520A master card comes with the fallowing:

® One - 152m (5 ft), 2 by 10 pin output data ribbon cable with viclet
label

® One - 152m (5 ft), 2 by 10 pin strobe/data ribbon cable with viclet
Iabet

® One - 152m {5 ft), 2 by 10 pin input qualifier ribbon cable with gray
label

* Two bags of probes and feads for the output data/strobe cables

* One bag of probes and leads for the input qualifier cable

* Three ¢lip-on label holders and sheet of cable and probe fabels

Each HP 16521A expansion card comes with the following:

* Six - 1.52 m (5 ft), 2 by 10 pin output data ribbon cables with violet
labels
* Six clip-on |abel holders and sheet of cable and probe labels,

Each hag of probes and leads for the output data/strobe cables
containg the followng

* One prohe adapter pod

¢ Eight output data probes (viclet tip}

® Eight 51 mm (2 in ) signal ground leads {black)
* Two 152 mm (6 1n) pod ground leads (black),

Each bag of probes and leads for the input qualifier cable contains the
following

* Eight input probes (gray)
* Fignt 51 mm (2 in } signal ground leads (black)
* Two 152 mm (6 1in) pod ground leads {black)

Cables and Probes
21



Connecting the
Probe Adapter
Pods

Cables and Probes
2-2

The illustration below identifies all the probes and assemblies

g~ BLACK GROUND. LEAD
PROBE Tsmmnon% GRAY SIGNAL LEAD

o

~. '—////\_BLACK GROUND PROBES

~

€

The probe adapters fit onto the end of the cables to provide an
alternate means of connecting to your target system There are ten
probes on each adapter  To attach a probe adapter to a cable, simply
push the adapter onto the end of the cable Both the cable and
adapter are keyed such that they will go together only one way




Attaching Labels
to the Cables

Since you may have as many as 27 cables and 270 probes attached to
an HP 16500A with one master card and four expansion cards, it is
helpful to have some method of quickly identifying them. Clip-on label
holders for each cable and stick-on labels for each probe are provided
for just this reason

To attagh the clip-cn label holder to a cable, just shide 1t on o the edge
of the cable as shown below Then remove the appropriate label from
the sheet provided and stich 1t Into the recessed rectangle on the label
holder. Notice that there are labels that conform to the slaots in the
mainframe and the cable number on the card For instance, if

CLIP

you have a pattern generator master card n slot A of the mainframe,
and you are using only the output data and strobe channels, you'il need
to label the two cables A2 and A3 since there are two output cables
from a master card The A indicates that the card is in slot A Looking
at the card from the rear, cable numbering is from left to right Thus,
cable two 1s i the middle and cable three is on the nght of the card
You'll want to attach a chp-on label holder to each and labe! cable two
{erght data channels) with a red A2 sticker and cable three {data/strobe
channels) with an orange A3 sticker.

In you are using an external clock or input qualfiers, you'll need to
connect cable one to the external input connector, which is on the left
of the card when locking at the rear of the board. Attach a clp-on
label holder to the eable and the brown A1 label

Cables and Probes
2-3



The dagram on page 2-B shows all the connectors on master and
expansion cards along with numbering and function.

Attaching Labels Each pattern generator card is supplied with a sheet of prabe

to the Probes numberling labels. The probe fabels are color coded to match the cable
tabels IF you have a red A2 label on a cable, there are elght red labels
humbered 0 - 7 that go on the probes of that cable  This color coding
makes it easy to identify which probes belong to what cable in case
you have numerous probes ntertwined on your target system.

Each of the violet probe tips has a recess on one side to allow for a
probe number label To label a probe, remove a stick-on label provided
and place it i the recess on the probe tip. Start with probe 0, which is
furthest frony the pod ground leads.

SEE DETAIL A

PROBE
ADAPTER

“—BLACK GROUND PROBE

DETAIL A
-~
&
PROBE
TERMINATOR —
|
™ @—PROSE LABEL
RECESS |f
FOR
PROBE LABEL

1AE2R/EXST

Cables and Probes
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Connecting Probes
to Your Target
System

There are also labels for the input quabfier probe. These are for
external clock {CLK), input wait qualfiers (W0 - W2), and test (TO - T3).

©Of the ten probes on each probe adapter, eight are for signals and two
are for connection to the circuit ground  All signal probes are gray,
wlth a vlolet probe tip, The pod ground probes are black and do not
have calored probe tips

The colored probe tip at the end of each probe has a gray lead to
cannect the output signal to your target system. There is also a
detachable signat ground for each to help mamntain signal fidelity
Whenever practical, we recommend that you usa the signal grounds

There are several ways to connect to your target system First, the
probe leads will connect directly to an IC chp or round pins with a
drameter from € 66 mm (0 026 n ) to 0.84 mm (0033 1}

You may alse clip directly onto your circuit using the opticnal grabbers
with the probes  To connect the grabbers to the probes, simply push
the probe lead onto the pin in the head of the grabber

If you have a pan strip header or square pin connector on your board,
yuu can remave the probe adapter and plug the cable dirertly anto
your connector The connector must have pin spacing of 2,54 mm (01
in }, pin size of 063 mm {0.025 n } and pin height of at least 5.97 mm
(0235 In). A polanzed connector equivalent to 3M* part number
3592-500X o 3592-600X is suggested. A non-polarized pin strip header
will also work provided it meets the spacing and pin size requirentents
given abave

“3M s a registered b ade mask of Minnesola Minng and Manufacturing Co

Cables and Probes
2-5
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Cables and Probes
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Using the Pod and
Signal Grounds

The probe adapter has two separate giound leads that aflow you to
connect all the signal grounds to a common ground. Thess pod
grounds may be connected by plugging directly onto pins or by means
of the grabbers

At higher frequencies, using only the two pod grounds may affect the
edge slew of the output signals Il you are concerned about the
possible slewing of output signal edges, we recommend you use the
individual signal grounds provided with each signal lead The signal
grounds should be connected as closely as possible to the individual
signal feads on your target system The signal ground feads are
connected to each probe as shown below

—GROUND

18516/ EXE2

Cables and Probes
2-7



Connecting Cables on each pattern generator board there are two sets of output
for ECL or TTL connectors, one for TTL output and one for ECL output. The following
Output diagram shows the location of each

ECL OUTPUT CONNECTORS

EXTERMAL INPUT
CONNECTOR

5
]
K
IS
1\
I
&

Lz

TIL QUTPUT CONNECTORS

MASTER CARD

ECL RUTPUT CONNECTORS

E
E
E
E/
E
E

EXPANSION CARD

186320/E%18

Cables and Probes
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The cables are connected to the TTL outputs from the factory on all
factory-installed boards  The procedure for connecting the standard or
optional cables is the same and Is as follows

1 Hemove the cable restraint by taking out the Torx head (number 10}
screws that hold the restrant to the board,

2 Plug the cables onto the TTL or ECL board connectors, depending
on the type of output you need Each cable 1s "keyed" and will
go on only ane way. The key on each cable should face toward
the rear of the board, 1, toward the endplate.

3 Lay the cable restraint over the cables Make surg that all
cabtes are routed through the notches in the restraint I
the cables are not routed through the notches, thay may get
pinched when the restraint screws are tightened

4 Replace the cable restraint screws.

Looking at the back of the hoards, the pod cables are numbered from
left to right, as shown on the previous page

On the HP 16520A master card, pod 3 contains one clock channel, four
data channels and three strobe channels  All eight channels on pod 2
are data channels Pod 1 contains the external clock and input qualifier
channels. The violel or gray label on the cable shows for what each
input or output 15 used.

On the HP 16521 A expansion card, all s1x pod connectors are output
data, with eight channels per pod

Cables and Probes
2-9



Cannecting Patterns for the Input qualifiers are set in the Listing menu with the

External Inputs Instruction field 1f you use the mput qualifiers and external clack, you'll
need to use the Input Qualifier Probe Cable, HP Part number
16520-61601

Replacing a Cable  If you need to replace a catle, follow the procedure glven under the

headmg "Connecting Cables for EGL or TTL Output® earlier in this
chapter

Removing or Should a probe break and need to be replaced, or you want to remove

Replacing a Probe  unused probes to keep them out of the way, use the following steps:
Lead

1 Hold the probe adapter with the label facing you

LATCH OPENING

/)‘\
~
Y \\
=
\\

SN

= Z

=

£ =

////V -

i =

-

P =

e \\ b

// ol ~ -~
-
Cal s

i 185 I5/EKR
2
=

2. Insert a pen or other pointed object mto the notch of the

Cables and Probes
210



probe you want to remove The notch 1s located at the point
where the probe goes into the probe adapter, Press firmly
into the notch while pufling gently on the probe lead

The probe lead should pop out

Natlce that one edge of the probe lead Is beveled so that it goes into
the probe adapter only one way To reinstall a probe lead, simply push
the metal prongs of the lead into the probe adapter until the lead snaps
into place  When the lead s in place, you should not be able to pull It
out .

G

BEVELED EDGE

14818811
The data probes will have two metal prongs, while the black ground
proves have only one

Cables and Probes
211



3

User Interface
Devices

System Power Up

Basic User Interface Information

The HP 16500A has three user interface devices: the knob on the front
panel, the touch-sensitive screen, and the optional mouse. If you are
unfamiliar with any of these, this chapter covers the basic concepts of
their use. For more detailed mformation, refer to the HP 16500A Front
Panci Operation Reference

When the HP 16500A system is powered up, the menu you see should
look simiar to the one shown below

( Fygstem ) (Contiguration [ Frint

B —
Cards

a|PRTTEPH GEREPATOR
MASTER — S0 Mbat =

E} | Mause

g|PRTTEFT GENERATOP

— - E —
C
] -
Cantroller
g —
D - P5—232C
I
1 =
L]
E __!T!___..!gl.....!EEE!_
Printer

Basic User interface Information
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Using the Touch
Screen

Any dark-blue field on screen is a "touchatle” field That 15, if you
touch a dark-biue field, the field will toggle to another value, or a
pop-up will appear allowing you to select ancther function  For
example, touch the dark-blue field labeled System in the upper left of
the screen A pop-up appears showing all the modules and software
options of the mainframe The actual order and content of this pop-up
may vary depending on the modules you have installed and which stots
the modules are in.

—_—

Lan|
it

[Print |

System

Car Intermodule

I

_J_| EL ) touze I

g|PATTERN GENEPATOR HP-IB

E4PrIDEP

Notice that the System field in the pop-up 15 tughlighted in light blue,
This tells you that you are ih a system ment To move to any module
i the hst, touch that fiekd in the pop-up  The pop-up wilf ¢lose and the
module chosen will appear oh screen

If you are in any other module menu, you can return to System by
touching the module field in the upper left of the screen  When the
pop-up appears, notice agan that the module you are in 1s highhghted
in ight blue Remember that the dark-blue field in the upper left of the
screen allows you to move among the modules

Basic User Interface Information
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Module Menus Each module may have several menus within it. To sea thase menu
selections, touch the dark-blue field seccnd from the left at the top of
the screen.

( systen M . (Print

Cards

PHTTER! CEHEPATOR

H H
HASTER — S0 Howlts

p|PHTTEPH GEHEFATOR
EPRIDEF

r

o S i — F3-7320
R
T

£ — - [ — | r_—|

I Printer

This menu field works the same as the module field to the left of it,
except mstead of showing all the medules, the menus within each
module are displayed For instance, if you touch this menu field while
you are in System, you'll get a pop-up that looks like the one shown
below

[ su:tem m— (Frint |

Configuration
Cards Pear Nisc
5 PHTTERN GENERRTOR
MHSTER - S0 Mbitss{[ || Front Disc
g{PATTERN GENERATOR Utilities
EAPANDER
Test
C
™ o= .
Controfle
8 @ P3=2520
] L b
—
—
E | —
Frinter

Basic User interface Information
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Moving to the Touch the module field in the upper left of the screen. A pop-up will

Pattern Generator  appear simiar to that shown below displaying all the modules and
software options in the mainframe, The actual order and content of
the pop-up wilt vary depending on the rmodules you have instalied and
their slots. The capitalized letter to the right of the module name refers
to the slot in the mainframe where the module 15 installed

In this example, to get to the pattern generator menus, you would
touch the field labeled Pattern Gen A

wmn [ Print
System
Car[ Intermodule
B | Mouze |

a3}
~-I8

PATTEPN G
HASTER —

E

B PATTEFH GEHEFATOP

E4PANDER 1 .
4
—
£ _H_JE | “
Frinter

This will bring up the pattern generator Farmat menu.
 Pattern Gen A | { Formst | {prunt | Pun
Input Clock Period R
TTL Internsl 200 ns lS'I’DDE:

995 ) oy 3 Pod A2 Pod 86 Pod BS Pod Bd
Ld TTL ian

0

N

n

l‘%gmnnl‘ I

B
— * d
'LBDEI | — EETHEHEE ’QETHEHEE D’ETF«EHED

>
[ovose | |- |
OHTA
orf
art

103 0 i ()

XYY

(1] LR XL

oit
oft
Dft
orf
rf

) o[ oatr
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Pattern Generator  The pattern generator has six menus  You can access them by
Menus touching the menu field to the right of the Pattern Gen A field. Touch
the Format menu field which 15 currently being displayed.

' Patlern Gen A l

Input
T
Fods |
| Pod A% Pod A2
) 4 »
(Label !l P o0 o 7 i

STROBE + bl
DATA + EET S ELTE TR

ort
art
art
art
off
orr
orr
arr

| IStruhes)l ] Symbols

Pod 54
LE THCHEE

A pop-up appears with all the pattern generator menu selections

[ Pattern Gen & | w—— lF’rlnI. | I Fun |

—] Formatl — .
Chpud Feriod _
TTL 20U nz l:l\'nnes| lEgmhnls
— Lizting
R T Pou Ba Pod 53 Fod B84
Lonet | | St TIL ETHCHED  DETACHED  DETALHED
(GLENY b 23 0| MACPOL List a7 - n
5 TPOBE Ler |
oo Tn .| rACROZ List :
ot MACROZ Lict
ot
otr HACPOA Lzt L7
oft
ot
ari
are
ore

The following chapters will familiarize you with these pattern generator
menus. For now, touch the Format field in the pop-up menu o return
to the Format menu  Just remember that the field next to Pattern Gen
always shows which pattern generator menu 18 displayed

Basic User Interface Information
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Data Entry Fields

When you need to enter alphanumeric or numeric data In some fields, a
pop-up keypad will appear on screen to allow you to enter the
information in this pop-up, there is a field labeled DONE. This field
lets the instrument krnow that you are finished entering data. The
keypad pop-up will not close until you touch the DONE fleld.

What's the Knohb
For?

L Fattern Gen A | l Lizting J l Step |‘_Prml | ( Pun J
Instr ]l.'D_ﬁi

wou 1l 1

Label-

Be SE"

— l : ]l o J_e ILF
=1 = @1 2

'l s e I
= ! G
copy Hm

| Insert I

.DBi

To the nght of the screen 1s 3 knab  Turtuneg the knob ailows you to
roll the scraen up and down for lists, left to right when getting to
information off screen, or for positicning the cursor when entering
information from a keypad.

Basic User Interface Information
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Using the Mouse Everything that can be done with the touch screen and knob on the HP
16500A can also be done with the optional mouse. The mouse plugs
Into the connector in the lower right of the front panel  As soan as the
mouse Is plugged in, it i3 aclive

When the mouse is plugged in, a white cursor {cross) appears on
screen  Moving the mouse causes the cursor to move. To "touch” a
field with the mouse, move the cursor to the field and press the left
mouse button

To use the mouse to perform the functions of the front-panel knob,
hold down the right mouse button and move the mouse  When you
release the right button on the mouse, the function returns to the
cursor

Basic User Interface Information
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4

Setting Pattern Generator Values

Introduction

In the HP 16520A/16521A Pattern Generator, similar functions are
generally placed together under a singfe menu. For instance, the
operating values of a pattern generat:on program are under the Format
menu, where you set the format of your data The Listing contains the
hst of patterns and the sequence in which they are to go out. And the
Macre menus let you write macros to eiminate entering redundant
pattern sequences

This chapter tefls you how to set the pattern generator program values
like data output rate, strobe width and delay, and the channels you
want to be active. It also tells you how to group channeis together
under a common, user-defined name All of these tasks are dohe in the
Format menu

The pictoral index on the next page gives you a visual map of the
Format menu It gives you the name of each field in the menuw, along
with the page or chapter number where you'll find more information
about its function

All the pctures in this manual were taken from an HP 165004 with one
HP 16520A master card and one HP 16521A expansion card. If the
srnreens on your instrument differ from the pictures in this manual, it
simply means that you have a different card configuration. All other
functions will work the same except where noted

Setting Pattern Generator Values
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Format Menu Field

P ¢ ? %

Index ///[ Paltern ien A | [ Formal | 55) (? (E| E} 0
o} I (o (5 | ﬁw
H - ; N
(e Label | 3‘?;'0 TP%%LLD ?E%gtﬁgg QE'?S:EEE 921”‘3[3&13 1:;
CLE »
FC 0:2 LT
HS "
FiH .
@) uos N
Los \ +
oft \\'"—"\ ~,
orr (‘—ﬂ
arf -
ort
Description Manual Page or Chapter
1 Module Fieid 3-2103-3
2 Menu Field 3.2, 3.4
3  Pnint Feld Chapter 11
4  Run Field Chapter 7
5 Input Type Selection Field 4-14 to 4-15
6  Clock Source Selection Field 4-10 to 4-12
7  Clock Period Selection Field 4-10to 4-12
8  Strobe Definition Field Chapter 9
9  Symbol Definition Field 4-15, Chapter 8
10  Label Felds 4-3 to 4-B
11 Qutput Polarity Field 4-9
12 Channel Numbering 4-6
13 Pod Mumbering 4-6
14  Channel Assighment Fields 4.7 to 4-8
15  Honzontal Roll Fleld” 4-13 to 4-14
16  Label Roll Field 412 to 4-13

* Appears only If one or more HP 16521A expansion modules are installed
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Naming Channe}
Groups

Turning Labels On

Menu: Format
Fields: Labe! (9)

Each channel you're going to use must be assigned to a label. A label
is & name for a channel ar group of channels, ke ADDRSS or DATA
You can give the label any name you want, up to a maximum of six
alphanumeric characters All the labels appear i the leftmost column
of the screen.

When the Format menu first comes up, it has twa labels already
assigned You'll notice the label STROBE in the upper label field and
DATA n the field below it. These are the defauit [abels. The labels can
be changed, but the default labels appear at first because every label
must have a name {.e, you can't have a label that contains only blank
spaces).

To turn a label on, ycu need to touch the fabel field you want to turn
an

( Pattern Gen A J L Format -] ‘ Print
Inpul Clock Ferioi ( l
l T“I]'L | ll”t””“dl a0 ne J StrobesJ Sumhulsl
Prds | oog ez Pod A2 Pod 86 Fod BS  Pod B
(Lave | 2 ) om TIL DETACHED  DETHCHED  DETHCHEQ
kLl Pol 03 0 7 o7 07 07 n

Q=]

ore

ort
ort
ore

When a label field is touched, a pop-up appears with three choices:
Turn Label On, Modity Label, and Turn Label Off. Touching the Turn
Label On field turns the label on and assigns a default label If the label
has been previously defined and then turned off, the previous label will
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show when you turn the field on agam.

aitern Gen A | Format \ Print | Pun
Turn Label O1f - —
lock i
llmer,m 'iz.ﬁ*n' l lS?rUbESI [SI;mbnisJ

put
L
rlod: 1y Lebe! Pnd H2 Fogd A Fod B3 Pod B4
T [\ETHEHED DETHEHEP OETACHED
7 & i u

ort

ot

Turning Labels Off I you touch a label field, a pop-up with three ehoices appears on
screen’ Tum Label On, Modify Label, and Turn Label Off. Toturn a
iabel off, touch the Teld labeled Tum Label OH.

Farmal ] [ Print m
Tt Clock Period
Ll I_, N B S T l Strobes | Symbo s

DETHCHE[I DETHI HED
7 Il

Hadify Label

Turn Label On

DATA + +
orr
oft
ot
nff
off
orf
oir
nrr

Turning a iahel off does not destroy the iabel name you have defined
If you turn the label on again, the name will stilf be there.

Turning off a label causes all assigned output channels to go to their
disabled state
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Modifying Labels when you touch a label field, a pop-up appears with three cholces.
Turn Label On, Modify Label, and Turm Label Off Touching the Modify
Label field causes a keypad to come up on screen

' Primt W [ Run
Period
00 e lELrubes I Symhalz

FPaod B5 Pad B35 Pod B4
- OETACHED  DETACHED
T u 7 i)

Clack
Internal

-Rod A2

25 25,

ofr
ort
orf
ory
orr
orr
ofr
arr

From this keypad you enter the new label Spaces and any other
special character on the keyboard are allowed in the label To clear the
label and start over, touch the CLEAR key. If you make an error while
entering a lahel, you can move to the character you want to change
with the front-panel knob and enter the correct character When you
are finished with the label, touch the DONE key

[ Pattern Gen A | ( Formet | '.Prmt !
Input | [ Clack "
| o ‘ - Rernd | stroves| [ symbors |
1 Pods

7] porrs  ASTROBE[Ter  eoses  poagy
CIEEEEEEIEIEIET
CEECEMEEIE)
EOEEECEEE
Anaonangs
'cLﬂ] | sPAce | [L

—
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Pod and Channel
Numbering

If you touch a label field that says Off, you don't need to turn the label
field on and then modify the default labet  If you touch a label that is
turned off, just touch Modsfy Label when the pop-up appears and enter
the desired label

WMenu: Format
Fields: Pod, Channel Numberlng (11,12)

Above the channel enable fields are the pod and channel numbers,
These tell you where each channel is located The channels of each
pod are numbered from right to left, starting with channel 0. Together
the channel humbers across the top and the labels along the left side of
the screen make up a matrix  While the numbers across the tap
indicate the physical grouping, the labels on the left show the logical
grouping

This area also tells you if the output cables are connected to the TTL
or EGL connectors, or If the cables are disconnected

(_Fntllern Gen A | ( Format J !‘Prmt

. R —
lm’“t ‘ I:lm l Rarad ]lstronesJ ngmnn'ls}

TTL nternal
Pnds
Pod +2 Pod B6 Pad B5 Pod B4
]u PR L DETSCHEL — DETRCHED  LETACHED
Label J|™Fgi =03 o T o7 07 b7 i
STROBE e
DATH (31T akEdEdED

orf
afrr
arr
att
ort
orf
ort
ofrt
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Assigning Output
Channels to Labels

Enabling Qutput
Channels

Menu: Format
Fields: Channel Assignment (13)

The process of assigning channels tells the pattern generator which
channels are active and to which label each channel belongs.

Each label gan have more than one channel assigned to it. For
nstance, you may have 16 channels assigned to the single label DATA.
However, a channel can be assigned to cnly one label,

To the night of each label are fields allowing you to specify which
channels froim each pod are associated with that label In other words,
each label may have several channels assigned ta i, but thase channels
need not be on the same physical pod  The channel enable fields let
you select where you want each signal to go

[ Pattern Ben & ] ( Formst | [Print |
Thput | [ Cloc Per Lod : \
l l[nternu] (300 n: lsgmbnhl

TTL
Pod w3 Pod A2 Fad BB Pod A5 Pod B4
T ik DETHLCHED DETHCHED LCETHCHED
7 il

Fods
bl L_" hd TL
WI Fol_ 30 7

lStrohva

a H 07 n
STROEE e - _1
DATA [ W* 1 - s }77
ot
ort
orr
oit
0it
ort
ort
art

Tourchmg a channe! enable field causes a pop up window to appear.
The pop-up has two fields with "** and ".” characters on them The "*"
(asterisk) causes a channel to he enabled. For each channel you want
ernabled, you need to enter & "*" in the channel enable field. You can
move to each channel by using the frant-panel kheb

After entering "** for each channel you want enabled, touch the DONE

hay to close the pop-up
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Disabling Output Touching a channel enable field causes a pop-up window to appear
Channels The pop-up has two fields whh "*" and "." characters on them The "."
(period) causes a charnel to be disabled For each channel you want
disabled, you need to enter a "." in the channel enable field You can
move to any channel by using the front-panet knob  Or, you can easily _
disable all the channels in the ped by touching the CLEAR field

[ Pattern Gen # | ( Format -} [ Print
N —
Tnhpul [J—f—l-ﬂ‘l—‘-‘—?ermd [_
TﬂL e an ni lSlrube; sqmnma.
' Puds Faod Fod BS Pod 54
Lapel I, TTL » DETHCHED  DETACHED
Pol 203 . 7 v 7 i
STPOBE o I__.
DATA E DONE I
ot S —
[l

ott
off
ot
air
ofr
ort

After entering "." for each channel yau want disabled, touch the DONE
key to close the pop up

( Patterncen s | [ Format | (Print
Input eriod J ‘ N
M .beruJ l‘S mlamsJ
Pods | pag —— | PudB5  Poc B4
Looe) | o=t | TTL * DETACHEO  DETRCHED
el | Fo 2o3 . 7 b7 0

STPUBE o | I
LHTA * = i

ort
ore
aer
or
otr
orr
otf
are
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Specifying Output
Polarity

fMenu: Format
Fields: Output Polarity {10}

The fields between the labet and channel enable Tields specify the logic
polarity of the pattern generatar output  The field toggles between "+
and "-* when touched There 15 one field for each label For data
channels, a positive sign { "+" ) Lells the pattern generator to send out
signals that are a igh voltage if the pattern requested s a 1. The
negative sign ( "-" ) specifies a low vaoltage if the requested pattern s a
1

[ Paltern Gen @ [ Farmal ' Print

Input Clock Feriod o
™ Trlernal 2 pe [Strnhe; LSumans
J
Pad AZ Pod A2 Pod Bb Pod 55 Pod B4
Lebal |D " TTL TTL DETHMCHED  DETHCHED DETACHED
] 203F o 7. L o_ 7, o7 0

Pods
‘ »
Fol
STROBE ™
DATA werr | [ovavasns

off
ot7
arf
arr
ary
ard
are
orf

Selting Pattern Generator Values
4-9



Setting the Data
Qutput Rate
(Internal Clock)

Menu: Format
Field: Clock Source Selection (5)

The clock, or what might more correctly be calied the output data
clock, drives the pattern generation hardware Each time a new clock
period starts, the pattern generator outputs go to thelr next state, as
defined by the llsting you specify in the Listing menu

The clock field allows you to select an internal or external clock., When
you touch the field, It will toggle between Internal and external,

Specitying an Internal

Clock Period

( Pattern Gen »‘-l] l_ Format :] !m -
| I:'F;'Et l!f :Sﬂlﬁg lStruheﬂ l'nghnl

l E] Pod At Pod A2 °nd B4

m Pol 203 a7 a ? -‘EHi

DATA wake | [revnnsan

ntr

ot

arf

arf

nrf

art

ofrf

ort

The HP 16520A/16521A powers up with the Clock Internal field
showing This means that the clock driving the pattern generator is
coming from inside the instrument  The internal ¢lock has a selactable
petiod, via the Period field. When you touch the Period field, a pop-up
appears with all the nternal clock period choices The periods are in a
1. & 5 sequence from 20 ns to 200 Us.  Touch any field to select a
perod and the pop-up will close
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( Fattern Gen A | [ Format Print |

Input. Clock
| T |IntPrnnl (stropes l 5!’"“15]
F'nﬂ H3 Pnd A2 Pod 86 a5 7 Pocl B4
‘Lahel TTL DETRE,HE%

Flﬂ 2 l’l 3 Ju] K ]
oaTa [P |} [
ofr
afrr
orr
off
ofr
ors
art
ofr
. .
Setting the Data Menu: Format
Qutput Rate Field: Clock External (5}

{External Clock)
If you touch the Clock Internal field. it toggles to Clock External. The
HP 16520A/16521A can be driven from a user specified external cloch
The clock is supplied through the EXT CLK pin of pod 1 on the master
card (HP 16520A). Pod 1 of the master card must be the HP
16520-61601 Input Qualifier Probe. The pattern generator changes
data on the rising edge of the external clock There will be some
propagation delay from the rising edge of the external clock to when
data is output
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Specilying an External
Clock Period

Any extarna! clock is run through a divide circuit on the pattern
generator master card When you choose Clock External, the fleld to
the right of the clock fleld changes from Period to Divide by 1 By
touching this field, you can also select Divide by § or Divide by 10,

This gives you more capability for strebes  For a complete explanation,
see Chapter @ of this manual, "Defining and WUsing Strobes,”

Roliing the Screen
Vertically

{ Fettern Gen A | [ Farmet ] Print |
[ Tnput Claock —_—
TTL lE-ﬂEl'l'lﬁ]_ I Symools I
‘ Pods | pag Az Pod A2 Pod B as Fod Bd
L LI S T L DETACHED
zpel o1 7 u

o CHED

Por_ 207 0
STROBE -
DATA pakt | [eosrarns
ore
014
o1
orv
ot
orr
off
oIt

Menu: Format
Field: Label Roll (15}

Up to 20 labeis can be assigned in the pattern generator Since only
ten labels can be displayed on screen at one time, you can use the
knob to roll the list of labels up and down to display any group of labels
you like. Above the label fields there is a field that says Label. When
this fleld 1s hght biue, the knob will roll the labels up and down. If the
field is dark blue, touch it and it will turn light blue
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Rolling the Screen
Right or Left

( Pettern Gon A | ( Format |

Input Clock Period
T Infernal 200 ns

Fod AZ

| Struhe_sJ [ngbulaJ
S £

bd Bd
DETACHED
7 n

—_—— TTL TIL
i 3 7

Pod B& Pod B
DETHCHED ~ DETRCHED
? o 7 1]

Menu: Format
Field: Pods = + (14)

If one or more expansion cards are installed in the mamframe, the knob
serves an additional function With 2 master card connected to at least
one expansion card in the HP 165004, there are more channels than
can be displayed on screen at one tme. The additional channels are
off screen to the right. To get to these channels, touch the field in the
upper left of the screen Jabeled Pods + = This field will turn light blue,
indicating that it 15 assigned to the front-panel knob. Thus, when you
turn the knob, the screen will roll left and right.  Iif the Label field,
discussed on the previous page, Is hght blue, the knob will roll the
screen up and down  If the Pods + » field is ight blue, the knob will
roll the screen left and right

Note

The Pods + = field will not appear if you have no
expansgion cards instafled.
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Setting the
External Input
Signal Type

( Pattern sen A | Former ) (Prant J [ Fun

Input Clock Period
T'T'L ] lInternﬂ [2‘1!" n3 I[Slrnbes

-
.Pnd B6 Pod _BS Pod B
~JHCHED  [ETACHEL EETAEHEP
a T [ B

i

lSUmDO'\ E

sond A3 Pnd A2

(Lavel ] [S55;
STROBE E
"

DATA

at1

Menu: Format
Field: Input Type {4)

if you are putting a signal into the pattern generator, like an external
clock or nput gualtfiers, there 1s a field in the Format menu to allow you
to set the threshald of the incoming signal. Touch the input type
selection field, and a pop-up will appear with three cheices for input
signal threshold TTL, ECL, and User Defined.

Touching User Defined will cause a numeric keypad to pop up on
screeh  From this keypard you can enter the threshold voltage of the
external clock and external input qualifiers
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( Fattern Gen ] L

Format |

"

&
PerLod i
3P0 ns lStrnDes ngmDDlS

‘r i"”i Pad A7 L Pod B Pag 85 Pod B4
@l o DETHCHED  LETACHED  DETACHED
m et Uszer Detined
[ATA EAT CITYIrTT “

arf
afr
arr
atr
arr
orr -
art
off

Frar more information on using and setting input qualfiers, see Chapter
10, "Setting Instructicns”, and the section entitled WAIT

Using Symbols Menu: Format

Field: Symbols (8)

Symbols are defined in the Format menu, but are used in the Listing
menu Because of this, symbols are covered in a separate chapter.
Please see Chapter 8, "Creating a Symbol Table.”

Setting Patlern Generator Values
4-15



<

Introduction

Entering and Editing Output Data
Patterns

In the HP 16520A/16521A Pattern Generator, similar functions are
generally placed together under a single menu. For instance, the
Listing menu contains the list of patterns and the sequence in which
they are to go out. The operating values for that hist of patterns, such
as output rate, are set in the Format menu, where you set the format
of your data And the Macro menus let you write macros to elimnate
entering redundant pattern sequences

Thrs chapter tells you how to enter and edit a pattern generation list
These functions are performed In the Listing menu

The pictoral index on the next page gives you a visual map of the Listing
menu. [t gives you the name of each field in the menu, along with the
page or chapter number on which you'll find information about its
function
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Listing Menu Field (P (%’ L? L? ‘f{)

Index { Patterntenn | { Lisung | (step |(Prant | ( Fun )
- Caver | tnstr Jfoe J(Foee)fns (e (s ){Los ) —(3]
[ Bate [BLnurg_] fmnurgJ | Binary || Binary ]LBmurl,l | |EJ_‘€)
@— | Delete |
@}_ Iterge ] @
4%+ STHET OF PPOGRAN +es
@Fﬁ_nnl—llﬁ) TR B R s B A o
l 1 o u
r—] 9 - ‘ :
1 b ' ' f
@)_ Incarl || #** END OF SPOGPAIT o 1 ! l
Description fManual Page or Chapter
1 Module Field 3-2to 3-3
2 Menu Field 3-2, 3+
3  Step Run Field Chapter 7
4  Print Field Chapter 11
5  Run Field Chapter 7
6§  Golumn Roll Field 517
7  Label Fields 5-4 to 5-5
8  Numerical Display Base Fields 9-3
9  Line Delete Field 5-8 to 5-9
10 Program Merge Freld 5-12 to 5-14
11 Line Number Field 5-6
12 Lline Copy Field 5-10 to 5-11
13 Lline Insert Field 5-8
14 Instruction Field Chapter 10
16  Data Entry Fields 9-7, 5-14 to 5-16

Entering and Editing Qutput Data Patterns
5-2



Setting the Display
Base

Menu: Listing
Field: Numerical Base (8)

Immediately below each of the labels is a field showing the numerical
base used to display the pattern for that fabel You may display the
channels in binary, octal, decimal, hex, ASCIl or as a user-defined
symbal

For example, assume you have a label with three channels assigned to
it If you want a pattern 11 1 for those three bits, you can enter it in
binary as shown, or in hex as 7 The number bases allow you to enter
and display the program data in a convenient form.

The default number base 15 hex. If you want to change to ancther
base, touch the numerical base field and select the base you want from
the pop-up

Pattern Gen b | [ Listing ) (stee J(print ]  Pun )

Label| [ 1nstr ][cu _J[FI: ozz}(ﬂ NEERNE I\@

p— —

&G e ) e )

Bese -

Delele

-

Herge

wkw STHRT FROGEAH =
—
wes END FOGP T

Copy

O [2

Tnsert

i
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Reading Labels

Changing Column
Order

Menu: Listing
Field: Label {7}

Labels are defined and output channels are assigned in the Format
menu Each of the labels are displayed across the top of the screen in
the Listing menu, left to right in the same order as in the Format menu

The Label> Base> field in the upper left of the screen point to the rows
that contain the label and numerical base fields respectively

All data for the Listing menu is entered into the data fields below each
label.

Menu; Listing
Field: Label (7)

Even though you defined the label order in the Format menu, the order
may hot be convenient for the Listing menu.  You can change the order
of columns in the Listing menu without affecting the order defined in
the Format menu. To change the order of columns, touch the labe!

field

( PatternGena ) [ Listing | ( step J(Print ] [ Fun )

[LQDTJ [ 1nstr ]W (mn_] (orn J[am  |{m HE
Base: —

'u_] | Binery ]IE]I\GJ

—_ =
Blnard
-
lDelete
o)
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Program Line
Numbering

A pop-up witl appear with all the labels listed Touch the field in the
pop-up that you want to move

(" Patrerncena | [ Listing | (stee |(Pront]) ([ Pun )
e | e (G s ) (e JmI(e)
Q (oener[ S, [12anery] (Binary | [Binery | (Rinal
Lelele

o
o
=

nerge E
T?P; ?r P??%R =TH
HEw g
: [1]
w+» END OF PROGRAM| g1y
Copy [n=tr

Insert

HGN!

The pop-up will close  Notice that the label field that you first touched
and the label you touched in the pop-up have exchanged places.

Menu: Listing
Field: Line Number (11}

The field at the center left of the screen shows the program line
number This field shows the current line that can be edited. When the
pattern generator is powered up, Iine 0 is the only one in the new
program And, all data fietds are zero

Each program will start at ine 0
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You may move to any line in a program with the front-panel knob,
Since the knob may also be used to move the screen left and right,
make sure the program line numhber is light blue befare you try to move
to 2 ine  If the Label> Base> field is light biue, the screen will move
left and right instead of up and down When the program line number
is ight blue, the knob will roll the program up and down.

( Patiern Gen & | ( Listing J | step ][Prln?] [ Fun ]

lm ((mestr J(eek J(Fcoez)(as (R ]{ues |@
Baser

[Emarg | [B1nary |[B:nnrg ] [Binary ) [Blnurg‘“ Bine|
‘Delete|

l Herge e

G THRT S

~

| Copy o 0
. " 1 1
l Insertl *re END L

In some cases, as when a program 1s several hundred ot thousand
lines long, using the knob may not be the most convenient way to move
through the program In such cases you can touch the program line
number (provided 1t is light blue) and a keypad will pop-up on screen.

Note

It the hine number fieid is dark blue, touch it once to use the
knaob and twice to bring up the keypad.

From this keypad you can enter the line number you want to move to.
When you finish entening the e nurnber, touch the DONE key The
kaypad will close and the program will jump to the specified line
number This feature can be used within the copy, delete, or merge
functions described later in this chapter
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Entering Data
Qutput Patterns

Menu: Listing
Field: Data Entry (15)

Output data 1s entered inte the data fields by touching them. When a
data field 1s 1ouched, a pop-up appears on screen, allowing you to
enter pattern data. The pop-up will vary depending on what value is
shown in the numenical hase field For example, if the numerical base
field is set to Hex, the pop-up will allow you to enter data n the range
of 0 to F If you select Binary, the pop-up displays only zero and one.

(' Fatiern 5an R ] ( Listing | ( step |J{ Frint | ( Run ]
lLahm. [ instr (o J(Fcoa](as J[r# Jlwos  Ifuos |

Baser [Elnﬂrg |[Blnnrg‘](ﬂlnarg |[annrg }[Elnurg] LBLnu

l Delele
l Herge
ey FPOGPF

o |
w5+ END GF PROGRAA

l Copy I
l Insert

If you try to put a value into a data field that is larger than the
maximum value that the freld can accomodate, the field will truncate the
entry, displaying as much of the entry as it can That is, if you bave
the numerical field set to Hex, but you only have one bit assigned to
the label, the only legal entries are 0 and 1. If you enter 5 and touch
the DONE field, the pattern generator will truncate the entry, leaving
only the least significant number, which is 1
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Inserting Program  Menu: Listing
Lines Field: Insert (13)

When the pattern generator is powered up, there is only ona program
line, line 0. To add lines to a program, use the Insert field at the lower
left of the screen. Each time you touch the Insert figld, the pattern
generator will add one line immediately after the one shown in the line
number field That is, if the line number field shows 7, and you touch
the Insert field, a hne will be inserted immediately after line 7.

( Patterncenn | Listing | (step J(Print ) { Pun )
Labelr} | Tnstr | [ctk (fcoz)(es  J[pu Jus 7oc |
[ J [Blllurg)iﬂlnarg][ﬂlnnrg l_ElnargJ[ﬂll’lBru IIE\

Delete |l vws START OF PROGRAH s
1 [a]uls]

Bacze

H

0 a0t

Nerge u}

o

Capy

Rl

Deleting Program  Menu: Listing
Lines Field: Delete (9)

You can delete one or more hnes from a pattern generation program
with the Delete field to the left of the screen First, position the ine
you want to start or end the deletion with in the line number field at the
center of the screen. When you touch the Delete field, two red
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( Pattern Eerﬂl Listing | ( step ](Frlnt_J( Pun )
[L“E'l[ metr V(o Jircoaf(m  J(pw_)[ums  Jfues )

Lﬁmurq ][Elnurg‘\ (Emu\'g W [Blnarg ] LBlnargJ [Bina]

Base:s

a wa
#wx END OF PPDGRAM +w+

Inseri

£

horizontal nas will appear on screen, one above and one below the line
in the hne number field A pop-up will also appear at the left of the
screen with lwo fields in it, Cancel and Execute. Use the front-panel
knob, or the pop-up keypad from the line number field to scroll up or
down in the program, until the two red ines encompass the ling(s} you
want to delete Then touch the Execute field in the pop-up. The lines
indicated will be deleted and the program will be renumbered

( PorternGen & | ( Listing | ( step J{pPrint | [ Run ]
(Cnstr J{oww MMFeo){as  I(pm J{ws  j{ies)

| Binary |[E\mnrg‘]lnﬂmnrgﬁ] Binary l [Blnaru ] @r

Delete

l Cancel

+¢+ START OF FROGRAN =+
1 >0

If you decide not to delete anything, you can touch the Cancel field
This will cancet the delete operation
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Copying Program
Lines

Menu: Listing
Fielc: Copy (12}

You can copy any portion of a program, provided you are not already
at the program hmit size {4086 lines). The pattern generator allows you
te select the number of coples as well as where you want those coples
n the program.

( Paltern Gen n] | Listing | ( step ](PI“]HLJ L Fon ]
L] = [ G [ [ [
Basp-

lElnﬂrg [[B1nary }[Eumru“ﬂlneru) |B1inary ]\Bina'i
Delete

H

Merge

a8

Inser1| s+ END

R

To copy program lines, position the first or (ast line of the section to be
copled in the line number fleld Touch the Copy field at the left of the
screen A pop-up will appear at the left of screen, with fields labeled

Execute and Cancel Two red, horizontal lines will also appear, above
and below the ine  Use the front-panel knob or the pop-up keypad
from the line number field to roll up and down in the program until the

red ines enclose the section you want to copy, and then touch the
Execute field  Now, if you want mare than one copy, touch the oval

field that specifies the numker of copies. A pop-up keypad allows you
to enter the number of copies. When you have finished entering the
number of copies, tnuch the Execute figld

Entering and Editing Output Data Patterns
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( Fatterncena | | Listing | (step J{Prant | [ Run )
Lobel+| [ Tnstr  Jlc NEEEICE ]rP‘HJ|UDG ]lﬂ:\
L Base: |E1nurg ](Blnarg |LBlnnrg]| Binary ||Blnaru l[ﬂlng

Select
LINES
w++ START OF PROGFAM +=+

To CORY 1 00 i 1 |
] oot N ¢
1 L 0 o

Cencel ? :‘
o " 5 o 0
v 1T i 1 I

=w4 END OF PROGRAM ~x+.

R Of

Naw that you've told the pattern generator what you want to copy, it
needs to know where to put the copies  The pop-up at the left of the
screen now profmpts you to mave to the location n the program where
yol want the copy(s) Move to the location with the front-panel knob
or by touching the line number field and entering a line number. When
you reach the point where the copies are to go, touch the Execute field
again  All the copies specified will be added directly below the line in
the line number field

(" PetternGen | [ Listing | (step J(Print ) [ Fun}
Laber+] [ tnstr (o J{rcoz){es  J(pa J(uos  J[wos |

| Brse: [Blnurg] (Blnarg] (Brnary l[Blnurg | [ Banary [Elhﬂ]
Select
LOCATION
. THRT OF FROGPAH
For capy[™™" S b om0 . | | i

a0l

o

In]
a
=
~ 0
@
—_—

If you decide not to copy anything, touch the Cancel field at the left of
the screen to cancel the copy operation
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Merging Program
Lines

Menu: Listing
Field: Merge (10}

The Merge field allows you to merge a pattern generator program
stored on disc with the program you are developing. You may also

merge one of the four macreos from the program on disc with your
program

[ PatternGenn | [ Lizting | [ Step ]LPrmt] ( Pun )
taper | [ tnetr J{ece )(fcoezies Jeai Jjuos ||ios |
Base- Binary J[Ehm]rg HEImuru_TLEmaru ][E.umry |[Bina|

|Delele —_— .

. ) [

PR | I
n .
l Copy 0 0

n " Y . 1 |
IInsert +++ END OF PROGPAH #+m

Position the fine number to where you want to merge the file in your
program. Touch the Merge field and a pop-up with five fields appears

l Paltern Gen RJ [ Lizhing | (Slap |(F‘r1nt | ( Fun J

i T S e der nea] g Jlem | |ups |{Lps |
Heryge ) frm—
[isc [ Front ] \Blnarl\]\Blnurg_][ﬂmurg H‘Bma\

| Cencel —_—
File name l |

|Ewecute
Herge I\Imn Prugrum]

+++ STRRT OF PPDGPAN +++

|l i S | S B

0 o]
PR o .o . ‘ \ \
IInEer, | w4+ END OF PROGRAM 4+
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The Disc fleld in the pop-up lets you sefect whether the program ig to
come from the front or rear disc.

Touch the File name field in the pop-up and a keypad appears for
entering the disc file name.  When you finish entering the file name,
touch the DONE field in the keypad.

At the bottom of the pop-up is a field labeled Merge This field lets you
specify whether you want to merge a main program on disc or one of
four macros that may be stored with that program

( PatternGena | Listing ] ( step [(Prunt | [. Run |
WP ¥ VS U |fFcava ] fuos ) 1astr)
Herge — . -~
’ Iiee [ Front | [lhary || Banary H‘Elnaru |

| Cencel |
File name I HEN-CYCLE |
|E4ecute|
Hernge Haih Progr

»e+ START OF PPOGPAH #++
0l 1 I ] 1
i) '

1 Q 0
| Copy H i h .

n n
| b

A | : | 1
|I"SEH I +4s END OF PROGPAN =+

Touch one of the choices to select what you are merging from the disc

( Pattern Gen RJ ( Listing | ( step |(_Pr'1nt] ( Pun )

T e I ne LW e In) \[FEOIJ][UDS IE In:lrl

=

nerge K ~

g_ Dise ' Fronl 1nary | [Eluaru ] {_ﬁmal’u ]

| Cancel | | o
File name M

First Hacro
Herge a

Second Hacro

wer START R
II] | Third Becro

Fourth Macro

[e] 0

e e =]

Copy . . ‘.

ot ] 1 : 1 B I
lI“'Er'l w+» END OF FROGRHM #4
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Using Autoroll to
Enter Data

Two fields on the right side of the first pop-up allow you to cangel the
merge function or tn execute It after you've entered the source of the
prograrm, its name, the portion to be merged If you do not want to
merge anything, touch the Cancel field. If you touch the Execute field,
the program or macro wil! be pulled fram the dise and added after the
current ine of the program or macro being edited

( Pattern Gen HJ ( LlEllrlg;J‘

{ step || Print | ( Run ]

i L0 Teas (R Llee s [as iLP’N X\LIJDS HLDS
nerge

Disc I Front |
lcun:m
_F1ie name HER_T
-

[ Binary | [ B1nary | [Bimary | [B1na]

!

| Copy ]
.
l [nserl] ~++ END OF PROGRAR w=s

If you do not want to merge anything, touch the Cancel field

—_-Ca

Menu: Listing
Field: Data Entry (15)

When entering pattern generation data, you may go across the screen,
filling each data field i the ine before going to the next program line
Or, you may want to fill in all the data in a column and then go to the
next column  Whatever method you choose, Autoroll makes moving
froni one data entry field to another easier than touching each in
succession

When you touch a data field and the pop-up appears, hotice that a field
also appears at the left side of the screen labeted Autorell. The cefault
for Autoroll is OFf. When you touch the Autoroll field, another pop-up
appears with three choices: Off, » l and l

Entering and Editing Qutpul Data Patterns

514



( Fatiern Gen H:] { Listing 1 { Step 'I(F‘rmt] ( Pun )

[Lnbeh}fﬂﬁl'ﬁ:{m—} e Jfoos (s |

c
(rnacn 1s 1 e inaey 1 amnrq“amam ||'Bu1u|

Lol 1]
Eﬂlﬁ [‘cueng] (Loone |

1: i_1le JLo ]
N . ‘

Eage

lenser’t +3+ END OF PROGKr

If the » & field is touched, the pop-up will close and Autorell through
the fields in the program line from left to right each time you finish
entering data {touch the DONE field) When you finish entering data
into the last field on a line, the pattern generator will automatically jurmp
to the first field in the next line. This continues untl the pattern
generalor reaches the end of the program or until you turn Autoroll off.

Autoroll @

STWAT DaTA ENTATEDIT

I
P

W
EDrﬁT: ' !__,,.—f’
FIELD ) e

( ._-;_;__,-
e
e e T B e S
= ——
P

-
ENND OF PROGARA UTORIILL TURIIE OFF
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Autoroll | &

STeAT DATA ENTRLEDIT

(, — O T
IZEI s (R s I |
DATe
EINTRA
FIELDS
s N s Y s S s S w|
(k s S s S v S v R

EHIR OF PAOGRAM (AUTOROLL TURNS OFF

If you touch the | field, the pattern generator will move down the
column ycur are in, advancing to the next field under it each time y¢
finish entering data ({touch the DONE field), as shown below  This
cnntinues until the pattern generator encounters the end of the
program or you turn Autoroll off

Entering and Editing Qutput Data Patterns
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Moving the Screen  Menu: Listing

Left or Right

Field: l.abel> Base> (6)

Since you can have more labels than can be displayed on screen
horizantally at one time, the pattern generator has a Label> Base>
field  This field, located in the upper left fo the screen, allows you to
move to those labels that are off screen either to the laft or right,
Touch the Label> Base> field and use the knob to roll the screen in
either directron.

[ Paltern Gen A ] l Listing | ( Slep '(Prlnl-] ( Run ]
Ilﬂleleta
==

4ux STAET OF PPOGRAMN wes

o) I [ ] [0 L1 J[1 11 ]
o 5 T T ‘

] ]

[ Inetr 2)(ps J[rH ] (ups )(cos |

Binary [Bmarg J [Blnnrg] {51“5]

.

Copy

[l

Theerd [|*** END OF PROGRAH +%«

To return the screen to the vertical scroll mode, simply touch the
progratn iine number field
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Introduction

The Macro List Menus

In the HP 16520A/1621A Pattern Generator, similar functions are
generally placed together under a single menu. For instance, the Macro
List menus let you write macres to eliminate entering redundant pattern
sequences. The operating values of a pattern generation program are
under the Format menu, where you set the format of your data. And
the Listing contains the list of patterns and the sequence in which they
are to qo out.

This chapter tells you how to write and edit macros for use in the main
pattern generator program. Macros are written on one of the four
macro list menus Each of the four menus 15 the same, so the
informaticn in this chapter applies to all.

Most of the functions in the macro st menus are identical to those in
the Listing menu This chapter explains only those function that are
unique to the macro st menus  IF you are uncertain about how to
¢reate a pattern generator hst or program, refer to Ghapter 5 of this
manual, "Entering and Editing Output Data "

The pictoral index on the next paqge gives you a visual map of the
MACRO List menus. It gives you the name of each field in the menu,
atong with the page or chapter number where you'll find more
information about its function,

The Macreo List Menus
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MACRO List Mey 9

R

Field Index

Paltern Gen A | [ MACROI Lict |

[ Step ](_F'rinl) ( Pun j

[me’ [ 1nsir

J[rove_ J{oete J(nwe ) (teen ) (Tstare }(esH0) —(7)

Bace.

[ Hex ]l Hex ][ He =

J Hee [Elnnrg \‘ IE}*@)

O]
@ |

o-(=)
o)

Description

Module Field

Menu Field

Program Step Run Field
Print Field

Run Field

Column Rcll Fielg*
Label Fields

O ~NOmMmP N -

9  Line Delete Fiald

10  Program Merge Field
1t Line Copy Feld

12 Line Insert Fieid

13  Line Number Field
14 Instruction Feld

15  Data Entry Fields

16  Parameter Fields

ves END OF HACRDG w+=

Numerical Display Base Fields

,
o S e B B B TEIC)

I]LID

TG

Manual Page or Chapter

3-2 10 3-3
3.2, 34
Chapter 7
Chapter 11
Chapter 7
547

5-4 to 5-5
5-3

5-8 to 5.9
5-12 to 5-14
5-6

5-10 to 5-11
5-8

Chapter 10
5-7, 3-14 to 5-16
6-6 to 6-7

* Appears only if there are more columns than can be displayed on screen at once
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What is a Macro?

Naming a Macro

Macros are separate programs that can be called by the main pattern
generatlon program Often you may have a sequence of patterns that
15 repeated many times within the pattern generator program, like a
handshake sequence Rather than having to enter this pattern
sequence In the main program every time you want a handshake,
macros allow you to define the seguence once i one of the four macro
lists, glve the sequence a name, then call that macro by name In the
main program. So, instead of having to enter the pattern sequence
eacl titne, you can specify the macro name, and the patterns in the
macro will be output, saving both effort and program space.

The pattern generator also allows you to pass parameters to the
macros For example, suppose you are dong a lat of writing to the
memory of your system and you'd like to define a macro to take care
of actuaily writing to the RAM  Each memory access differs only in
address and data. With the ability tc pass parameters, you may define
the access routine in a macro and then pass the address and data to
the macro. This makes the macros much mare general purpose whila
cutting down on the amount of time it takes to develop pattern
generation programs.

Menu: MACRO List
Field: Instruction (14}

Macros can be given any six character name you want  To name a
macro, touch the Instruction field in ine 0 of the macro list,

{ Pattern Gen A | ( HACPO1 List ) {step J(Peant ] [ Pun )
Lover- | [ tnstr J{eooe |[DaTa J(Nbe | {W_pen 'llzsrarlz]la—s_fol
l Bese- [ He- ][_ Het J[ Hex ]| ke |[anurgJ|::EEj

—
| Delete |
| Herge

)

wns STHRT
PHRANE TERS

g

l Copy | sas END OF HECRD wwn
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Setting Pass
Parameters

The Macro List Menus
64

A keypad wliil pop up, allowing you to enter the macro name, When
you finish entering the name, touch the DONE key. When the keypad
closes, the macro name will appear in the Instruction field and the Menu
field at the top of the screen,

{ Pattern Gen i | T FEnHR List | (step J(Frant | ( Pun ]
Lenels mstr |{ok | (Feas2)(es J(ru ) (ups |[E]
[ Besan Binary J[RHH LR ]lnurq |[BlnurgJLBmurgJ [Blnnl

blolale Al Al
HEOLEEET
(cerr] [ seece] m

s s}

<ol
Flr

Menu: MACRG List
Field: Parameter (16)

The pattern generator allows you to pass parameters between the
main program and the macros  There are two parameters available for
each label in the list The parameters fields appear in mes 0 and 1, in

what would normally be data entry fields. They are labeled PARAMA1
and PARAM2 N

(( PatternGen A | [(RAIR List | (step I{Pront | ( F’un-]
LQDQHJ [ znstr )[soor ) [{eata | [waw ]| n_pan || 2sTaTE | [ £5HD)

Bazes

lDelete
| Herge l

«»+ START OF NACPO =

C o) || m—

PrFAT PAFAM.

iy Uy

l Copy I «sx END OF HRLPQ »==

LHE;. IL He. II He ]I Hes JHEJnurng He |




The parameter fields differ from data entry fields in that they will not
accept numeric input like a data entry field Instead, when you touch a
parameter field a pop-up heypad appears, allowing you to enter a
name The name can be up to six characters, and the parameter can
be referred to in the rest of the macro by this name.

(" Patterncen A | (RAN_WR List | (step I(Prant ) ( Pun )

Label® Instr fooe | foata | [nwe [ npan || zsTaTE | 85HO)
l | He= [HDRUHL]HM [| He: J\lEunur’gJLi}

LECEEECEEEIER
ClEEUNEEIRIE] -
] ) | ] T
Bunana
(cLemr| [ seace ] g_

The parameter name can be used in the rest of the macro when
referring to the parameter When narning a parameter, you are naming
a variable that is passed into the macre from the main pattern
generation program As an example, suppose you have a label in the
main program entitied ADDR. You'd like to pass an address value into
the macro, so you might want to name one of the parameters under
the label ADDR, ADRVAL, for ADDRESS VALUE You can then refer
to this parameter {variable) by its new name, ADRVAL, rather than just
PARAM

Bacze:

HF
=y
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Editing a Macro

Parameters do not have to be renamed. You may use the default
narnes of PARAMT and PARAM2 if you wish

Creating and echting a macro 15 wirtually the same as creating and
editing a program in the Listing menu  To insert, delete, or copy merge
lines in a macro, use the Insert, Delete, Merge or Copy fields at the left
of the screen, just as you would in the main program in the Listing
menu. The functionality of these fields is the same in the macro or
main programs, with one exception. You can not delets, edit, or insert
within bnes 0 - 3 of the macro

I

The Macro List Menus
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( Pattern Gen H | [Fﬁn_HP List | ( Slep ](Frmr | ( Run '
Cabel | | tastr [{apop J[owte J[uwe | {n_ken |[357aTe || asko|
Baser [ Hit || Hes ]L Hed ‘\[_ Her Hﬁumruj\ He |
‘ Delete ‘
wws STHPT OF MACRI) #xe
PHH_HP ADPYAL PAPANMI FAPAN! FARAMN | FRPAM1 PEPA
PHREMETERS  PRPANZ PAPAN2 PAPAM. PARAML PHPAME  PHPRH
l Herge l a0 9 u DUFI o
& SR | S

You may also use instructions ih a macro, to repeat a line, wait for
external input qualifier values, wart for an IMB signal, break, or send
out an IMB signal The instructions are inserted in the Instruction FReld,
|ust as in the Listing menu  However, you can not insert instrugtions
intg the first two ines of the macro, in the Parameter figlds



Calling a Macro
from the Main
Pragram Listing

Entering patterns Inlo the data entry fielis 1s also done in the same
manner as in the Listing menu  To enter patterns into a field, simply
touch the field and use the pop-up keypad.

_[ Pattern Gen & | [ RAM_HP Lizi | (ster J(Prant } P )
Caver-| [ mistr J{eoor J{oata (nowe ) (weer ][ 1STATE ]@I
lEasa'n [ Hes }[ Hes || He» ]L Hew |{Binary HE|

|DE]ETE
#+x STRET OF HACFO »+=

PAN_MP RDOFVYAL  DATYAL  PRARAMI PAPAMI PAPAM PHPH
PRRAHETEFS PAFAN2  PAFANZ  PARAHY  PAPAAZ  PRPAMZ  PAFPA
l Her ge l o - . - .

C e |C— 0 J - 1
+++ END OF MACRO wwe
|Inserr‘

Menu: Lisling
Field: Instruction (14)

To call a macro from the main program, touch the Instruction field of
the line in which you want to invoke the macro.

_(,F‘utiern Gen A | [ Listing ) (Cseep I(prant | ( Pun )
Cabel-] [ 1nste J[wpoe  |(vate  [[nowe [ {H_pon | ESSIED
Bssnl L Hes “ Hesx J[ Hev || Hee |[Bunary || He |

IDe\elE|

Herge | »xa START OF PROGRAR +#+
ono G

1 i 1

Ny

——

18

Copy

N

Insert

i
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When the pop-up appears, select one of the MAGROX fields, depending
on the list where your macro is. If you have named your macro, that
name will appear in the pop-up

( FetternCenn | [ Listing ) ( Step J(Prmt] [ Pur |
[ 1nstr Jleooe ) [owte | [nwe ) (n_pan ) (ssTATE || 6sHo|

[ Hes ]L Hew ]L Hew J[ Hew ][anrqﬁ“E\

Lebel:

——

Brse:

|

belete I None
Herne | wss STAPT | PEPEAT MACROE
HALT HACPOS

HHIT IHB MACPO4

Lopy | BPER an . : o

Theert SIGHAL IMB| o7

[1]fe]

a0H BF

Whenever yBu select a macrg in one of the Instruction fields, another
line will appear below it The word Parameters will appear in the
Instruction field of this second line.

( Patlern Gen A | ( Lisiing ] t_ Step lLFr‘lhI ] ( Fun ]
Laver+| [ tastr |[eoo  |(peta |[nie )| w_ear | [3sTATE | \?ETUI
l Ea;s»] [ He+ ][ Hel, ][ He s ][ Hia [Emnru H He |

Merge | wre START OF PROGRAN =»»
plelu} 00 i 111 l

) |nw =1 1 1C | —
FHF'HHETEFS ' ' " |

aol 03 " e
) 2 . .
s L2 . .

l Lony l nod o ' Co
003 A0 ! !

aog 08 " v

aoy 26

l Insert I 63 o7

" 4 1al=] 1E -

The data entry fields of these two Iines {the one in which the macro is
called and the parareter ine below it) can now be used to enter the
values that will be passed to the macro  There are two values that can
be passed to the macro for each label in the hsting.



An Example Macro The following program segments are examples of a simple macro for
writing to a RAM and the program that calls it Notice that data and
address values are passed mto the macro from the main program  The
macro has been renamed RAM_WR  Also notice that there are two
parameters in the macro, under the labets ADDR and DATA that they
have been renamed to ADRVAL and DATVAL, for ADDRESS VALUE
and DATA VALUE, respectively. The second parameter for each label,
PARAMZ is not used, and is allowed to assume the same value as
PARAM1, ADRVAL, or DATVAL.

(" Pattern sen A ) [(RATWP List | { step J(Prant ] [ Run )
Label s
Eaze+

lﬂelele]

| Herge

[T %DHTVHL PARANT | [PaRafl ] [PAFAR] ] [FEFE]
(:‘ FHPRHETEF‘S Pnpnn_ AP LFEWTT‘ ARAMZ  PARRAI  FARA
PEPERT

" DATVAL

- a
| tony I REPEAT IS e o 9

RFEPEAT ¥ - e ! 1
|Im,, w#x END OF HACPO <o+

l_ Patiern Gen # | ( Listing | l step ItF‘rmt ] ( Run J

Label
Ease-

ven START OF PROGPAH »xe
IDHlele onn ] 1 1 I 1
HAIT 001 o i : i .

((anstr J(wock | [oete | {mow | [s_pan ) (ssTATE | [asko]

[ wes | Her || Her || Ha ||E|1nnrg]| He

[ 1nztr ]fnnnp | (oara ) (noe ) [npen | [-?GTHTE][EI

Hex LHev Jl Hee || Hes J[Bmarg]\ He |

ot no
i AM_HR ani 26
Herge | PRAFARETEFS  “ " '
AM_HE nni nx
FHFHHETEPS e ! ! !
e | e | Y | | m—
16 1 {|PAFRHETERS " - L
= PAM_MP [T TF '
PAPAHETERS e ' ! . ot
RAN_HP 004 ()
opy pqpﬁnsrsps v -
FAH_HR s A ! s
PHRRHETEPS e . ! ': :“

[41s].] 0B

PAH 0

PRFHHETEFS LR ' " " -
IInserl PAH_HR 7 6 " .

PARKMETERS [ P -
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7

Introduction

Run Modes

Running and Stopping
the Pattern Generator

This chapter will show you how to run and stop the pattern generator
and what the various run modes mean It also discusses what happens
to the output channels when a program s finished or stopped.

The pattern generator can be run from any menu. The procedure for
running 15 basigally tha same for all menus, so the Listing menu is used
as an example.

There are two basic run modes in the pattern generator, single and
repetitive In addition, the pattern generator can run independent of
other modules in the mainframe or i conjunction with other modules
through the IMB (Intermodule Bus) In total there are four possible run
modes

Independent Run Single- pattern generator runs once and stops.
Running is independent of other modutes in the mainframe Data,
sirobe and clock outputs are held at the state defined by the tast line of
the program

Independent Run Repetitive- pattern generater runs continuousty until
stopped Time between the last program line and the first is the same
as all other program steps. Runhning 15 ndependent of other modules in
the mainframe

Group Run Single- pattern generator runs once and stops  Running is
in cunjunction with other modules through the IMB - Data, stroke and
clock outputs are held at the state defined by the last line of the
program, - T

Group Run Repetitive- pattern generator runs continuously with other
modules in the matnframe until stopped. At the end of each run it halts
and waits for an mdication through the IMB that the other modules
have finished their acquisibons  The pattern generator then starts

Running and Stepping the Pattern Generator
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Running the
Pattern Generator
Once

another run at the beginning of the program.

An Intermordule menu lats you tell the mainframe which module is to
send an arming sighal and which modules are to act upon it If you
need more information on how to use the intermodule capabilities, see
the chapter in the HP 165004 Aeference Manual entitied “Intermadule
Measurements.”

If the field in the upper nght of your screen says Run, the pattern
generator is set to run independently of all other meodules, If, however,
the field says Group Run, the pattern generator is tied to another
module or modules through the intermodule menu

Menu: Any
Field: Run

To run the pattern generator once, touch the Run field. When the
pop-up appears, move your finger to the Single field in the pop-up
without lifting your finger from the screen When the Single field turns
white, ift your finger from the screen  The pattern generator will run

once and stop

' Patiern Gen # | (

Listing | (step J(Print ]
Label - Jleek  J[Fc o] fes | (ps [Los |
Base: —

BmargJ [Bmarg“ﬂlnarg I[E Pepetiil <
IDEIEte
I Nerge
«sn START OF PROGRAH #¢w

1 Qoo 1
|l 1[0 J[oer  JC— ][ ] {
T 5 5

o .
\ Lo .
l Copy i - . . "
a - .
=++ END OF PROGRAN e+
l'lnsertl

The run mode (Single or Repetitive} will slay In the last one selected
until you ¢hange it That 15, if you choose Single as the run made, it

( [nstr

Cancel
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Running the
Pattern Generator
Repetitively

wlill stay in Single each time you touch Run untll you change ft to
Repetitive

At the end of the run, the pattern generator data, clock and strobe
outputs will remain in the state defined by the last line of the program

Menu: Any
Field: Run

To run the pattern generator repetltively, touch the Run field When
the pop-up appears, mave your finger to the Repetitive field in the
pop-up without ifting your finger from the screen. When the Repetitive
field turns white, hft your finger from the screen Each time the pattern
generator reaches the end of the program, it starts at the beginning
again  The time between the last ine of the program and the first is
the same as ii the lines were contiguous

( Patiurn Gen A J (7 Listing ] [ step [[Print
Leper~| [ Instr ][oLk RN [[r:
Baser [Binary || Binary | [Binary || By

H

PDelete

Herge
ww STAPT OF PROGPAMN *++

| 71 o o

0l

Eﬂpu

Y S -

1] v
«+% EHND OF PROGRAM w»+
Insert

g

The run mode (Single or Repetilive) will stay in the last one selected
until you change it That is, f you choose Repetitive as the run mode,

it will stay in Repetitive each time you touch Run until you change it to
Single.

Runring and Stopping the Patiern Generator
7-3



Single-Stepping_
the Pattern
Generator

Menu: Listing, Macro List
Field: Step (3)

It 15 often necessary to have control over when the pattern generator
steps to its neat state For example, if you are using the pattern
generator to stmulate a prototype while checking the response with a
logic analyzer or scope, 1t is particularly helpful to be able to halt the
pattern generator when an error 1s found with the target system Itis
also helpful to be able to continue the pattern generation program from
that pant, rather than having to run the whole program over again.

The single-step function n the HP 16520A/16521A allows you to do just
that ‘You can insert a BREAK instruction into your program at any
pont, and single step through one or more program lines at a time
from there. The pattern generator can then refurn to its single-run
made For more informatlon on haw to use the BREAK instrustion, see
chapter 10 of this manual, "Usmng Instructions "

Note

The single-step mode /s onfy usable in Independent Run
Single and Group Run Bott Independent Run Repetitive
and Group Run Repetitive do not halt at a BREAK
instruction

A program can be single stepped from the Listing or any of the Macro
List menus with the Step field at the top of the screen. Touch Step

and a pop-up appeats

{ Petterngen e | [ Listing ! E‘[ Print | Run  §

Label | | Instr |lew  J[FC osz || ns
l Base:

| Delets
| Merge
++¢+ STEPT OF PROGRAM #++

IR | S S T O N

| Binary Hﬁmarg HLHmarg ll_

"

l Copuy ‘

[=E= R
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There are flve fields In the pop-up. The first, Step Count, lets you set

the num

ber of states or program lines that will be stepped through

each you touch the Step fleld. Use the front-panel knob to ¢hange the

step cou

int or touch the Step Count field and a keypad will pop up from

which you can enter & new number. The default is one state per step.

‘ Patlern Gen W | | Ly

Labe|
Baze

Pun

r W
First
l Sinte | o5 |[Lps |

——, Binary llﬁlnai

i

\

l[leletﬂ

(o —
7' Slep I L

l Herge I
{

TR

=»s STUPT OF PROGPAM »4e
[

[
[FI:3] -

‘ Capy ‘
lInsert‘

Touch th

= e

«++ EHD DOF PROGPAR +»s

e First State field and the pattern generator will jump to line 0

in the program  When the program jumps to line 0, you may single

slep the

] t_hz;t line.

program from there, even if there is no BREAK instructicn at

h

' Pattern Gen A ' Ly - A Pu

Lshel-

base -

e T [S5tep Coum - .
[ Instr Hﬂ[ " I E‘ ps  |[LDs |

(57

| [elete 1
—_—
| Herge ]
R

[} )

I EDP\J ‘

—

ree OTHRT ?F PEOGRAM +%+
oo 1 1
Jo1

LY N

0
s=s END OF PROGPAH wws

|Insert‘
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The Step field, found at the bottom of the pop-up, controls when the
pattern generator steps to the next program line  Each time you touch
Step, the pattern generator goes to the next ine and waits. The output
data, strohes, and ¢lock are held at the state defined by that line until
you advance to the next line.

Patiern Gen A | | L .

AR

Fun

1|05 |

— | 5tep Count First F—
o lLaheM Instr _[ELI' 1 State [

Base:

| B0

|Delale
| Herge

— tnary || Binal
@ { Recune I l Dong —
—

Co | O e

=3

Copy

| Incert

wes END OF PROGRAI #ax

) ATy

T= O = D= O

The Resume freid tells the pattern generator to stop sngle stepping
and return to normal operation  This is the only way to discontinue the

single-step mode

| Pattern Gen A ] { Ll—'—'—'-—‘—"‘__l ' Pun

DS [Los |

Banse:

— Step Count First
lung]. nstr | |cLe [ | l l State |

(51

|\3€-l\?le ‘
l Herge

ary \ Bl.ﬂﬁl
' Done

) B

| cony |
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When you are fimshed with the single-step run, touch the Done field at
the lower right of the pop-up

| Fattern Gen A | L : pi— | Pun
o " ——q |Step Count First —_—
Labet«] | Instr |cLk | State ns |[Los |
Base- | B3 . wiary || G|
‘ Step I | Pezume ‘ E -
lDelel9|

| terge
+w+ STAPT OF PPOGPAR #++

C ) |C ][ [ T 11

n [T

— 0
|
| Copy I B

1

—_— 0
| Ineert ) +4+ END OF PPOGPAH s+«

Stopping the Menu: Any
Pattern Generator  Field: Run

When the pattern generator is running repebtively, the Run field is

replaced by Stop  To step a program that is running repetitively, touch
the Stop field

[ Patlern Gen # 7 { Listing | ( Step J[FPrint |W-
Lavere| [ tmstr J[oe J[rcwealfes Jpm J(ups | |E
l Base: [Blnurg |[Brnary I [Emarg | | Binary | [Elnarg ) |;n
lDE‘E‘E
I erge l

x4 B PHO +&+
I G ] 1 1 1
o) [ g:au ] ][ ] [ |
| topy | ‘ :
o I ! 1 1
Imserl wes END OF PPOGRFM +++

O S =]
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The Stop field also ¢omes up duning a single run, but you may not see
it since the program 1s usually finished by the time the Stop field is
displayed However, if your program s several hundred or thousand
lines bong, ui if the output data rate is low, the Stop field will show for
several seconds

Running and Stopping the Patiern Generator
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8

What is a Symbol?

Getting to the
Symbol Table

Creating A Symbol Table

Because long strings of kinary patterns are difficult for the human mind
to recognize, we often give these patterns functional or symbelic
names, to make them easier to remembear. A good example of this Is
microprocessor assembly language. Rather than have to deal with
patterns ke 0011 0110, we can give the pattern a name like Jurmp or
Compare By Iooking at a list of these symbolic names in sequence,

we can decipher what a state machine cr processor is doing It would
be much more difficult to look at a list of binary codes and get the
same infermation. Appropriately enough, we call these symbolic names
Symbols

The HP 16520A/16521A pattern generator allows you to create a table
of such symbols  You can enter the symibol names into the program
without having to remembear the binary or hex cade for each. The
pattern generator can then display these names in the program listing
for ease of reading.

Menu: Format
Field: Symbol (9)

To get to the symibol table, go to the Format menu. Teuch the fietd
labeled Symbols in the upper right of the screen

( Pattern Gen A | ( Format ) 'm] Fun
Input | Cioct Period Al
I Internal| | 200 ns 5”'0'395'
Podg
PR Pod W3 Pod A2 Fod Bf Pod BS Pod B
Lebel | TTL TTL DETHCHED DETHCHED LETACHEL
Pol 203 o 7 1] T 1] 7 1] T 1]
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Entering Symbotl
Names

Entering a Pattern
Symbol

Creating a Symbol Table
82

Menuy: Format
Field: Symbol {9)

To enter a symbnl name, touch the label field at the left that says New
Symbol.

( Patiern Gen & | | Format 1 Iprint | pun |
Symbol Table Symbol
Hidth
Label [ CLF Base { Her ] 'Y ‘
Symbol Type Patiernsstrart Slap

' Lone |

Note

If you have previously created symbols for this label, those
symbols will be displayed. The fiefd New Symbol will nof
appear See the section in thi's chapter entitted "Adding,
Modifying or Deleting & Symbol *

A pop-up keypad will appear to allow you to enter the symbol name If
you make a mistake and need to backspace, use the front-panel knob
When you've finished entering the name, touch the DONE key

Menu: Format
Field: Symboal (9)

The process of entering symbol data has two parts  specifying the
channels on which to put the symbol patterns and entering the symbol
pattern or range



Touch the field that says Label

|_enttern Genn | I Formet

{Prins 1 Pu |

synbol Tabie

Type

Base

Symbnl

Meu =ymbal

| 5 mbﬂ 1
301
“i Binary ] ]

N\ . Stap

{ Dere |

A pop-up appears showing all the labels defined in the Format menu
Each label has data channels assigned ta it, so when you enter a
symbol under a label, the jpattern generator knows on which channels
to output the symbel data  In this example, there are six label names,

CLK, FC 02, AS. R/W, UDS, and LDS

{_pattern Gen @ | {  Format | (proni 1 Bun )
ymbol Table TSymbn |
1dth
Labu] e Bose ( Binery | l 5 |
Symbol FC ¢'2 Patltern Start Stop

E New symhol

p=| RS -

i FH

I urs

H L0s

I LDDHE |

Suppose, for example, you're going to define a syimbol hamed
USER_DATA ihat shauld go aut on the FG 0/2 channels Touch the
label FC 9/2 from the pop-up. This tells the pattern generator that you

Creating a Symbol Table
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want to build a symbaol table for Jabe! FC 0/2

Format 1

{(—_eattern Gen A | |
h ymbal Table

Binary )

{print 1 Pun |

Symbol
1dth ‘
3]

Label Base
Tymho s Mernsstany

e

( Done

Touch the field labeled New Symbol and enter the name USER_DATA

using the pop-up keypad

{_ Pattern Gena 1 { Formnt 1 {ecint 1 £ Run
h Symboi Table Synbal
Label [ FC 072 ) paze [ Binery | '%}h
Symbol Type Patiern/Stori Siop
t Dane J

Now that you've told the pattern generator where to put the symbol

pattern, you'll need to t

Creating a Symbol Table
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ell It what the USER_DATA pattern should be



Touch the field labeled Pattern/Start A keypad will pop up, allowing
you to enter the pattern After the pattern is entered, touch the DONE

key
l Pattern Gen A | I Format 1 {Prant | £ pun )
Symbal Table " Sumbol |
Label ‘ FC a/2 } Baze [ Binary l "dath |
Symhal Type PatlerntStart Stup
|i| USEP_DATA |[pettern] oo
[ (]
I TR S TN
Setting a Value Menu: Format
Range Freld: Symbol (3)
¥

In certain cases it may be useful to define a symbol as a value plus
some offset  The range term allows you to specify a value range for
the symbal, and an offset from the start of the range  The symbol
pattern then becomes the start address of the range added to the
offset

Creating a Symbol Table
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Taouch the Type field and it will toggle from pattern to range

( Pattern Gen g 1 0 Furmat ] Iprant | _Pyn
Symbol Tsble E}.]mnnl
—_—
Label [ FC N2 ) Bose ( Bimary | lmath ‘
Symbo1 Tupe FatiernsStart Stop

( Dore ]

A second field will appear in the Stop column te the right The
Pattern/Start column allows you to enter the start of the range while
the Stop column lets you enter the end of the range

' Patiern Gen A 1. Format | {ermt V0 Pun
Symbol Table Symbol
—_— —_— dth
Label { FC 02 Eoce | Binary | l ' }
Symbal Type Patigrn«Stari Stap

[r—mu |

( [user_oaTa [ range | [oom ] [ ]

e )|

To specify an offset, perform the following steps:

1 Go to the Listing menu

2. Teuch the numeric base field below the labe! you want symbols

Creating a Symbol Table
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displayed on

3 When the pop-up appears, touch the field that says Symbol

4 Touch the data-entry field below the label you've set to display

symbals

5 A pop-up labeled Symbol Selection pops up with all the symbols for
that lapel listed The list also ncludes an entry labeled absolute. Using
the front-panel knab, roli until absolute appears Iin the highlighted bar

6 A field labeled offset appears at the top of the pop-up  Touch the
numetic: field and enter 1the offset from the keypad

7 Touch the Done field in the keypad and symbol selection pop-ups to

complete the offse

t selection

The value range of the symbol cannot exceed the number of bits
assigned to the label. For example, there are three bits assigned for
the label FC §/2. so the range for a symbol would be 8 (0 through 7).

[ Partern Gen a ] {

Listing ] ( Step J(Fr\nt] [ Eun J

Labels | | TInstr ]

[tue (ns

Jlpoi  [fuos |

L L 11

Baczer

Autoraoll

(|

xe2 START O
[

Symbal Seleclion

orfset @

sbsolute
USER_DATA

T absolale
1 absolute -
n absolute *

llarnnrg [{E1nery |
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Setting the Menu: Format
Numerical Base Field: Symbal (9)

The fighl labeled Base allows you to select the number format for
entering patterns. The default is Hex Touch the fieid and a pop-up
appears with fields that allow you to select Hex, Binary, Octal, Declmal,

and ASCI.
( Pattern Gen g 1§ Formol 1 ferint i Run
Symboi Table Symbnl
T Hidth
Label | CL¥ Base g )
Symbol Type Pattern:Start

| =

| Don. '|

Touch the number base you want and the pop-up will close

Setting the Symbol Menu: Format
Width Field: Symboat (9)

in the uoper right of the Symbol Table screen is a field labeled Symbol
Width This field allows you to specify how many characters of the
d=Mned symbe! name are to appear in the Listing menu  The default
value is eight.  Keeping the symbel width as small as possible will keep
the honzontal width of the Listing menu smaller. This is important if
you have a large number of labeds. If you have several symbol names
that all have the same first four letters, and you set the symbol width
to 4, all the symbols will appear the same 1n the Listing menu  In such

Creating a Symbol Table
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Adding, Madifying,
or Deleting a
Symbol

a case, you'd need to set the symbol width to at least five.

Paltern Gen a | | Format 1 Ierwmt | pun ]
Symbol Table
Lepel { (LK | gase (_ Binory |
symbol Type PatterntStart Stop
{ oene )

Menu: Format
Field: Symbol (9)

When a symbao! table has no entries, the Symbol field will say New
Symbol Howaver, after the first symbnl name 15 entered, the New
Symbol indicator disappears and 1s replaced by the first symbo! name.

Creating a Symbol Table
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Creating a Symbo! Table
8-10

To add more symbols, touch the Symbal field A pop-up will appear
with three choices: Add a Symbol, Modily Symbol, and Delete Symbol

I‘ Poltern Gen & | | Format 1 leriwr 10 pun )
| Sumocl Tebie "%n.]u'.;;l_'f
hod 8 synbol [ Bose ( Binarg ) e

fodify Symbol Fattern. Start Stop
[ z
r Delete Symbol r

| Done

To adg a symbol, touch the field labeled Add a Symbol A new symbol
Iine will be added directly after the symbol field you touched

To medify an existing symbol, touch the name of the symbol you want
to change. When the pop-up appears, touch the field labeled Modify
Symbol A heypad will appear to allow you to modify the current name
The front-panel knob can be used to move the cursor to any part of
the old name for editing

To delete any symbo! in the table, touch the symbol you want to get rid
of and a pop-up will appear Touch the Delete Symbol field in the
pop-up and the chosen symbal will be deleted from the table.



Getting Out of the
Symbol Table

Displaying
Symbols in a
Program

Menu: Format
Field: Symbol (9)

To leave the Symbol Table screen, touch the field at the lower right of
the screen {abeled Done

L Patiern Gen 6 | {  Forpat | ipPrint 1 € Bun
Symool| Table Symbol
ST HgldU‘I |
Labet | CLY | Base (_ 81nery ] )
Symbol Type Paftern/Start Stop

H Hew sumbol

| pr—w |

Menu: Listing
Field: Numerical Base (8)

Ta display synibois in a program, touch the Numerical Base field in the

Listing menu A pop-up will appear with all the choices for number
base

{ Petfernmend | Listing | ( step jprint ) [ Pun )
LubEM] S IR ]_qu ]|F‘._N vz [[Los |
l Binary m - N

Haze

Herge

ald

«+«» START OF PPOGFAH m+4
ol } 1 [os [ I I L_
; L

001
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Creating a Symbol Table
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Touch the field in the pop-up labeled Symbol.

{_ Pettern Gen A ) ( Listing L coee dPrint I pm )
[thﬂ:v] Instr ] (Ln (Fc o2 C Bunary [ ) [ups [Los |

[Binery ME Octsl  ynary | [Binary ||Bins)

EBase-

|

DeIete‘ Decimal
— Her
Herge
e POGFEH +ws
o q00

aot

Copy

= I -

Insert j| *** END OF PROG

]

HH s

[}

The pattern generator will look at all patterns in the program under the
label you've chosen to display symbols. If any of the patterns match
those i the symbol table, the symbol name will be displayed for that
pattern

( FPatternGen | [ Listing | [ Step ][ Print | ( Fun }
Cavers] [ tnstr (o ) Foeez Jfes f[re l{ws )
[ EnseJJ [ElnnrgJ L Symbol ]|Blnﬂru] fﬁlnarg) [Elhuru

Delete

H

Herge

r'v STAFT D{{PPDEPHH L1L)
]

] [ebsolute ooo] [ 1 ICT ]

%!FFIWTF___J : T
absolute 0 0 '

ghsolute ' '

absolnte ' -

absolute "t N - 0

absolute ' ! : '

absolute '" 1 1

+w+ END OF PROGRAM s++

-
=

[}
-opy

10

-

Insert

All patterns in the ¢olumn that don't match any of the symbol patterns
will be displayed as absofute xxx. The numbers that follow the word
absolute will be the actual pattern for that ine, displayed 1+ the number
base used in the symbal table



Note

The ditte character (") is used in a program listing ta
fredicate that the pattern is the same as that Immediately
above if. However, the symbol table will interpret a ditto as
an absolute value, and will display it as absolute .
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9

What Is a Strobe?

Defining and Using Strobes

Strobes are data channels with selectable width and delay in the HP
16520A/16521A Pattern Generator  While standard data channeis can
change state anly at the start of an output clock cycle, strobes ¢an
start aftet the clock transition and can pulse even in the middle ¢f a
clack cycle Because of thelr selectable pulse width and start delay,
the strobes in the HP 18520A can be used in such applications as
creating asymmetrical clocks with greater or less than 50% duty cycle
DATA TRANSITION POINTS

¥ ‘h"\
g = (— LT

CLOCH

DATA
HANNELS

STROBE (+}

[ ] ] [ 1
STROBE -} LJI I_Ji u

In the pattern generator, all standard data channels are referenced to
the data output clock, whether that clock 15 internal or external. All
data transitions occur on the postive edge of the clock  That means
tlie data pulse width cannot be less than one clock perod,

—

SSRGS Ry P

'
\
)
]
1
[¥
I
I
|
|
|
I
|
I
'
'
1
]
'
|

]
]
'
)
1

*
v
i
1
]
]
'
|
|
|
|
|
I
|

Strohes are a special class of data channel. allowing you to specify
transitions In increments of one-fifth to one-tenth the data ocutput clock
rate For rates greater than 20 Ms/s, the strobe rate is the same as
the data output clack For rates less than 20 Ms/s but greater than 10
Ms/s, strobes can be adjusted in increments of one-fifth the clock rate
And for rates less lhan 10 Ms/s, strobe width and delay may be
speclfied in increments of one-tenth the clock rate Pulse width may be

Defining and Using Strobes
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Assigning Strobe
Channels

Defining and Using Strobes
9-2

set from one-tenth to one full clock period.

DATA TRANSITION FOKITS

DATA ¢ ™ '
OUTRUT
FLOCH
» 1

U N N s B
/

SELECTABLE PULSE WITITH

In addition, the start of the strobe pulse can be delayed from the start
of the output data clock n increments of one-fifth or one-tenth the
clock periad.

START OF DATA PERIDD

DATA -
QUTPUT

Lok
.
| H
| :
STROBE : ' ! ’_

]
lw—a= SELECTABLE DELAY
. :

Strobe channels are defined in the Farmat menu and controlled in the
Listing menu For each strobe channel, a "1" in the Listing menu tells
the pattern generatar to output the strobe as defined i the Format
menu, while a "0" disables the strobe By putting a one or zero in the
pragram histing, strobes can be enabled or disabled for each output
data cycle

Menu: Format
Field: Channel Assignment (14)

Each HP 16520A master card has three strobes. They are physically
located on pod 3 of the master card

Strobes are assigned in the Format menu, as are all the data ¢channels



Pod 3 of the master card has two channel grouptngs, ¢-3 and 0-2. The
right-most group of pod 3 (3..0) 15 data channels, as you can see in the
Format manu below. The left-most group of pod 3 (2.0) is comprised of
the strobe channels

( Pattern Gen & | |

Farmat J

[Print ] ' Piin )

Input.
TTL

Cloch
Internal

Per1anl
o -

)

‘ lstrunes

Pnd
| Rt | Pod i3
!;EE&;Q Fnl 2 4%

STROBE

Fod H2
TTL
7 1]

Fnud Bo Fod B3 Fad B4
DETRCHED DETHCHED OETHCHED
7 ] 7 1] T [i]

e

DaTa

[YETS

[T TN

off

orr

ore

ore
are
are
orr
orr

4TAOBE
CHANNELS

Strobes are assigned using the same procedure as for data channels.
Touch the channel assignment field and a pop-up appears with . and

e

"ow

. Assigned channels have a "*" while unassigned channels have a

(" Pottern cen a | [ Format | {pernt | [ Pum )
Iﬁ‘t' | E:ngortnknl] gggl:g lStrubes lsumnnlsi
_1232771 ; ’ P??wHY 1P$¥LH: $E¥EEEEE 32?3[322 gE%E:EEE
STPDBY
STROB |
STROBL
or
ori
ort
ort
ort
ort
arr

Using the pop-up keypad ot the front-panel knob, move the cursor to
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the strobe channel you want to assign, Touch the "*" figld to assign
the channel and then the DONE field

g F o —
( Pattern Gen A | ( Former | (Prant }
" Input ,-—u-nu—u—.F [T N I S
I-T-T-E ®, 0 v E[.‘ﬁa I lstruhezl lsumnnls i
Pods
Fod Pad B5 Pog B
Lobel u_*,‘ m - ] LETACHED  DETACHED
L-E_E_f Pol 2073 ' 7 1] | [a]
STPOBY - | ;._
" CLEAR q - .

STROBI

STROEZ
orr
ort
ort
orr
ort
ort
art

Strobes that are not assigned to a jabel will be output disabled

Y
Setting Strobe Menu: Format
Polarity Field: Polarity {11)

You can select negative ar positive polarity for strobes, The polarity
for strobes is set the same way as for data channels Touch the

polanty field for the strobe channels and it toggles between negative
and positive.

( Fattern Gen @ | { Format | (Print | | Pun )
Inpul Ciock Divige l PR S
TTL External hy 5 ] Strubesl lsymnul.

Pads | pogoaz Pod A2 Pnd 86 Pod BS Por B4
LELIERE L T DETKCHED  DETHCHED
7 ;

g}l Fol _ 2031 u_J 0 T 07

ort

ort
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For data channels, selecting negative polarity causes the output to be
inverted from the program listmg If there is @ 0 in the listing, the
output at the probes will be a 1

If you select postive polarity for strobe channels, a 0 In the pattern
Iisting telis the pattern generator to disable the strobe output, while a 1
tells it to output the strobe according to your definition in the Strobes
menu

If you sefect negative polarity, a 1 in the listing menu will disable the
strobe output and a 0 will enable the output. When the output s
disabled (1 1n the program listing}, the strobe channel will return to 1
{R1} instead of 0 (RZ) When the output 1s enabled (0 in the program
listing), the strobe output will be inverted. Whenever the polarity is
changed to negative for a strobe channel(s), the waveform in the
Strobes menu for that strobe(s) will alsa be inverted

( Pattern Gen & | t Format J |-Pr1nl ' Fun
Input ’ Clock Period i
T Internal 200 s | [EECLER I Symbols ‘

Fods - \ —— 5
o l + Delay Hidth TROBE |
(Lebel | 5o 2 160 ns i B — L
STROEE - STROBE 0
STROBE - Deley Hidth =
160 n3 40 ns
arf
STRDBE
orr Delay Hidth —-——-ﬁ r
arf 160 n3 40 ns
ofrt T T Y N RO Y |
ort lDD“E J — 1 Cloch Period—
off
off
oft
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The following chart summarizes the effects of polarity on the strobe

channels.
Pattern Polarity Output
{strobe bits) (at probes}

0 + disabled/RZ

1 + enabled/non-inverted

D - enabled/inverted

1 - disabled/R1
|
Setting Strobe Menu: Formal

Delay and Width Field: Strobes (8)

Strobes are defined by touching the Strobes field in the Format menu

( Patternkenw | [ rormat | {Print ' Fln
Input Clocl Period |
TTL Internal Sud na |

N l Symhbolc

— l P4 | Pog Az Pog Az Pod 86 Pod BY
Lebel I|Meor— 3 05 o 5 0 FUCEOBETERE
STPOBR .

STROB] .

STROBZ N

ore =

ofr

orf

off

ort

orf

orr

A pop-up will appear with all the strobes shown in waveforms at the
right of the pop-up. The left half of the pop-up has fields for setting
the delay and width of each strobe

Defining and Using Strobes
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Note

The Strobes field will not appear if the period g set to 20
ns (internal clock) or if the Divide by 1 field is showing
(external clock)

Touch any dark biue Delay or Width field ard it will turn fight blue,
indicating the value in it ¢an be ¢hanged with the front-panel knob,
You can also touch the light blue field again and a keypad will pop up
on screen, allowing you to enter delay or width directly Any changes
in delay or width made with the knob or keypad will be reflected in the
waveforms When you have finished setting the delay and width of the
strobes, touch the Done field at the bettom of the pop-up.

.
( rFatternwen s | ( Former ] (rrint ) Fun
Input Clach Period ~
T tnternai] | 200 ns sirones Isgmnols
Pods STROB.2 i
| ¢« » Delay l N B R
(Laver | |Npey B 190 ns 10V n3
STROBY STROBH
Dela | Hidtn
ETFUBI :l] n&
STROB2 .
5TROBO
arr Delay Hugeh | | ———"
ort L 8i) nz
ot oy
orr
ofr
orr
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Notlce the line labeled 1 Clock Period below the strobe waveforms
This line shows the relationship among the strobes and cutput data
clock

( Patrern Gen A 1 [ Format | (Frint |

Input | [ Clock Ferlog "
fnil tnternatl ] 200 ns I ngbols-J
t £ ) bal WLdth STROB2
————— 4+ * elay .
(Lobel | [ - [ v ns l g0 nsJ
STROBO STPan1
STPOB) De1my Hidth I e R
40 ns B0 ns
STROB2 -
" 5 TROBO
ofr Oriay Hidih _-_'—-—|—
pre 40 ns 80 nz
ute [ A IO I T |
ort ——1 Clock Period—
oy
art
arf

If you set the polarity of any strobe to negative, the pop-up will reflect
the change and the waveform in the pop-up will be inverted, as shown
below
( Fattern Gen A 1 [ Format | [Frant | ' Fun

Input Clack Perind T

L | |Intermﬂ]| 200 ns J_Im ":"Umh“‘-;l

‘ Delay Hidth 1 rAAEIEEEJ1
2 40 ne an s

Pods
+ 3
\Lavel | | ot
STPORZ s STROB.
2 I pelay | Hidth
STPOB= - A0 ns 811 n- L
STPOS | -

ort Delay ‘ Hidth
otr 40 nt Gy on:
ort

Oone
orr

art

ot
orf P

——1 Clochk Period—

Unassigned strobes will be displayed in the pop-up but the label above
the waveform will be In lower case text Strobes tha! are assigned to a

Defining and Using Strobes
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label will also have waveforms in the menu but the name of the label
they are assigned to will be in capital letters  Notice in the screen
below that the label above the middle waveform is in lower case letters,
indicating that it 15 unassigned.

l Patlern Gen A | [ Format | (Print | Fun |

Inpui ” Clnck
ITL Internal

Pods ] T STPOEZ
—— “« $ Celsy Hidth
!Luhel : I E—

Fol 2 10U ns 100 ns |

STROBA .

—

steo1 | [ | Deley ' Hidth ‘ usmbe !
40 ns 20 n3

steog2 | [+ | [+ :

Period
200 ns

Strobes I Symbal e
-

J

off Deiay I Hidth | _’——STDM—
o1t ' 0o l 50 ns

T T S N B IR B |
e l Cone —1 Clock Periog—d
urf

orr

ort

An unassigned strobe will alse be displayed in the pop-up with a default
label a3 Strobe 0, Sirobe 1, or Strobe 2 It is possible to have two
strobes with the same name in the pop-up if you use STROBE as a
label. However, notice in the picture below that even though there are
two Strobe Os, the lower label 15 1in lower case text, indicating that it Is
unassigned

[ Pattern Gen & l t Format | !F‘rlnt | ' Fun
Tnput | [ Clack Pertod —_—
TTL Internal 20 ng Symbots
-

Pods — —— STROBE 1
e + » Delay Hidth 4|—|—
(Label] POl 2 0 ne an ns
STRNAE o STPOSE o I

oir Delny Hidth
A0 ns 80 ns
arr
BT St a
Ll Delay I Width I ﬁ—
air 40 ns g9 ns

orr —— L B
o1r anne ——1 Cloct Period—
ofr
orr
ofr
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Specifying Strobes
With an External
Clock

Defining and Using Sirobes
9-10

Menu: Format
Fields: Strobes, Clock External, Divide By (B, 6, 7}

If you are using an external clock to run the pattern generator, the
strobes are still available  Just as the period of the Internal clock
determines the strobe rate, width and delay, so does the period of the
external clock

To specify an external clock, touch the Clock Internal field The field
will toggle to CGlock External When you switch to Clock External, the
Period ficld changes te Divide by 1

{ PatrernBenn | (_ Formst | (print]
[nput Clact nivide ‘
l T ] lEM.errlul by | lsu’“""”]

(%% ] poges Puaaz  Potss  Pog B Fos0a
(Love ) | L I ™ DETACHED ~ DETACHED  DETACHED
2 Fol 2031 0 3 o7 07 o7 i
STRABO .

STROB |

.

STROB2

oft
aff
art
arf
ore

ory
ort

When you specify Clock External, the Divide by field gives you a choice
of three different divisors Divide by 1, Divide by 5, and Divide by 10



Thase cause the external clock to be divided down by one, five, or ten
respectively. The pattern generator gives the options of supplying an
external clock which is five or ten times faster than needed to output
data. The external clock goes through an internal divider before
becoming the data clock. However, the external clock goes directly to
the strobes without division This enables the pattern generator to
adjust edges of the strobes tn one-fifth ar one-tenth of the clock
period That, in turn, allows you ta adjust the delay and width of

( FetternGen A | (( Format | [Frint )
Tnput [ Cloct 1
TTL Exlernal by 1 5trnhes| Ingbrﬂs]
Pod A3 Pod AZ P od B Pod B3
T TTL DE by 3 THCHED  DETHCHED
203 @ 7. 7 ] h 0
* | | by

: TT
. /|

the strobes it increments of one-fifth or one-tenth the data output
clock

If you select Divitle by 1, the Strobes field disappears, since the strobe
and data clock rate would be the same However, for rates of less
than 20 MHz, strobe channels can be used as additional data channels
by selecting Divide by 1.

Defining and Using Strobes
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What Happens at
the End of a
Program?

Defining and Using Strobes
812

Note

When using Divide by B, the strobe width and delay can
only be adjusted in increments of one-fifth the output ¢lock
rate. If you specify Divide by 10, width and delay are
selectable in increments of one-tenth the output clock.

If you specify Clock External, strobe width and delay are shown in
integer form with no units of time measure.  This 15 because the
pattern generator has no way of knowinrg what the external clock rate
1S

- —
( Pattern Gen fi | [ Formal ] LFrunt
Lhpnt Clock Divide o
m Eyternsl by 5 Sirobes Sumhnlsl

| % J Delay | | Hidth STRUBE
4‘“1 4 * 4——|__‘—
Label Fol = 3 I 2 ]

STROBE

T | — STRIBE 1
steoee | (- | [+ | Dﬂemg ] l Hidin I D

arf

b STPOBE ©
arf Delay Hidih m
ort B 2

off [ T R O T T TR I |
arr I Daone ‘ ——1 Clock Period—o
orr
oft
arr

5]

If the pattern generatar is in Indepedent Run Single, the strobes are
held at their last-defined state at the end of the program

The first time the pattern generator is run i Independent Run Single,
the hardware disables the output data clock and all the strobe output
channels as the first state of the program s loaded into the output
latches. of the program is loaded into the output latches  The
remander of the program Is then loaded Into the program memory.
When the mematy load is complete, the program 15 executed. During
the time that the program is being loaded Into memory, the strobes and



output data ¢lack assume the levels of the first state of the program,
and are then disabled However, the output data from the first state In
the program will be on the output data channels, If this data causes
problems for your system, you will need to tri-state the data channels
or enter a data pattern that does not cause problems as the first state
in the program.

If the pattern generator is being run in Repetitive Run Group or
Independent Rurt Repetitive, there are not delays as with Independent
Run Single In other words, the first state of the program follows the
fast with no delay in Independent Run Repetitive

Defining and Using Strobes
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1 0 Using Instructions

Introduction Menuy: Listing
Field: Instruction (14)

The pattern generator provides five instructions for use in a program,
and the ability to call any of four user-defined macros. Instructions and
macros are called from the Instruction fleld in the Listing menu

To insert an Instruction or macro call into a program line, use the
front-panel knob or pop-up keypad to move the line to the ine number
field Touch the Instruction field and a pop-up with all the instructions
appears

Note

The Instruction freid will always appear befow the label nstr
at the top of the screen.

R (rattern Genn ) Listing (Cster 1(prant |V { Fun )
[La\:sew-' | st Jloee ) [Fcesz])fes [P Jluos  J{Los
Baze B1na

\:Blnnrg || Binery ||annrg |[B:nnrg J| Binary lelua
Delete

| Merge |
exw STHRET “F PROGRAM *2=
o) | — >

10w JCo_ v Jrfc 1)

l Copy ‘
llnsgrt ‘ «r» END OF FPOC
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None Menu; Listing
Field: Instruction (14)

The first field in the Instruction pop-up 15 None, This fleld
does exactly what its name implies, by putting no
instruction in the field IF you touch None and there 15 no
previous instruction in the program line, it will close the
pop-up and do nothing  This allows you to exit the
instruction pop-up iin case you decide you do not want to
put an instrugtion in the current program line.

(_Pntu.-rn Gen & | | Listing | [ Step llPrml] ( Fun ]

- —_—
Cavers) | Tnetr )itk |[Fcovz](ms IR |{us |[ies |
[ Bze: | [Ejnnrg || Binary \[EtnargJ{BmurgJ\_Bmarg”Elna_\

Dale!e} M o HACPO|
wre START T

T

nerge FEPEAT
WHIT
{ El
HALT ING
wws END OF -
l Insert SIGHHL INB

If there is already an instruction in the line, touching None
will remove the instruction and close the pop-up.

REPEAT Menu: Listing
Field: Instruction (14)

The REPEAT instruction lets you repest a program line up
to 256 times When you touch REPEAT, & numeric keypad
will appear to allow you to enter the number of times you

Using Instructions
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WAIT

want to repeat the ine. When you've entered the number,
touch the DONE key. The pop-up will close and REPEAT
XXX (where X%X is the decimal number of repeats) will
appear 1n the Instruction figld

( Pattern Gen & _] ( isung | ( step |{ Print | [_ Pun ]
Leper-] [ instr (e V[Fc ooz | (65 Tlew  Jlus  |fLos |
l Bese! | Binery | [ Binary JFExnarg |[Binary | | 81nery |[Blna|

Delete

None HRCRO|

E

oTOn S

Herge

wse sTHRT | HRIT

0]

l copy

Insert

HAIT INO

BREAK

s+« END OF[SIGHAL IMB w

i

Menu: Listing
Field: Instruction (14)

Along with an external clock, there are three external input
qualifiers available with each master card The WAIT
instruction causes the pattern generator to wait at the
current program line until the three external inputs go to a
pre-defined state that allow the program to go to the next
program fine

Using instructions
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When you touch WAST, a table entitled Wait External pops
up oh screen. The table contains the eight binary
combinations for the threg external inputs, along with a
Result column on the right. The table lets you specify on
which of the three-bit conditions to wait and on which to
continue program execution.

t Fattern Gen @ | ( Listing | [ step ]lPrmL | { Fiih )
Labels Instr (ol J{FC0m2])es 1P Tfus  |[us |
l Basex | Binary 1 [B'Lnaru ] [Emarg J (EIHEFUJ \Fﬁlnarg | | E:nnl
[DE'E‘E None HACPOI

PEPEAT | HarPaz

carx STERT
)
HATT THB
Copy BREAE

Theert || *** END OF STGNAL IHB

]

For each bit combination, there are two possible results
Cont (Gontinue) and Wait  To change the result for a
pattern, touch the corresponding fiedd in the Result column
The field will toggle to the next value

[ Patlern Gen A ] ' ( Slep ”,P"“'” J

Lisking ]
—

— e, —— J —

Label-1 | 1Insir Weit External o | [uos JlLos |

Esternal Inputs — — —

Baces 2 1 ] Resull Rinary | [Binary HEII'IBI
0 ] n ( Het )

Ha

@ v |0 [ (Hart )
(e

ol |o ((Ha1t |
Merge o | 1 @
an

1o o (n
wms STHPT OF y
o 1 | I 1 I I ( et
1 1 0 war || 9

Wail

I | Done I
lInseri.l «s» ERD OF P

g




You can have from zerao to eight wait conditions The
default value is all eight conditions set to WAIT When you
have finished specifying the wait conditions, touch the Done
fleld in the lower right of the table

Note

The default valves of the Wait External table will cause it to
wait on any input condition. Therefore, before running a
program with a WAIT insttuction, you'll need to change the
wait conditions ta whatever values you need.

( Pattern Gen | [ Listing | ( step J{Print ] ( Pun ]
Tare1 L[ Tret Maitl E-Lernel F o uns LIS
Label ILI E'ternal Inpuis —l l—"] II—I
Base: < 1 o Pesult kinsry |[Blnarg | 181naj
] n 1] ' Cont | "
['Helel o] 1 L_Eﬂ)
4 | 0  HaLt ]

| Herge n 1 1 i Cont |

1 il ] Conl
+4+ STEPT OF (U

o | I R { Cont 1|1 O~
I 1| o { ront |

l Copy l 1 [ 1 { Cont .
lIn;er, war END OF P &_}

After you have set wart conditions and closed the Wait External pop-up,
the Instruction figld will display bit combinations that the pattern
generator will look for to continue program execution If you set a
single wait condition, the Instruction field will display WAIT §8% If you
set multiple wait conditions, the Instruction field will display the continue
conditions in an abrieviated form. For example, If you set wait
conditions on 004, 011, 131, and 111 the Instruction field will display
WAIT XX0, which megans that the pattern generator will continue
whenever the external input bit zero is a logic low. Remember, the
Wait External table allows you to specify wait and continue conditions
and the Intruction field shows you those conditions on which the
pattern generator will continue

If the Instruction field displays a §, it simply means that it cannot
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logically show all the bit combinations that were set  As an example, if
WAIT 380 Is displayed, it means that some wait conditions were set for
external input bit zero, but nat all. In other werds. of the four possible
wait gonditions i which bit 0 is high, only two or three are set.
Whenever a § appears in the Instruction field, it means that you'll need
to go back to the Wait External table to see all the combinations.

_ to.go back to the Wall External table f0 508 & The comuingtons

[ Pottern Gen @A ) [ Listing J [ step || Print ] ( Fun ]

Label:

Bese:

lDelele

’

s STHPT_OF PROGRAM 4%+
(o) |WRIT _s3n 1 00U [ | 11 |
[ [ELeTy) i ;

[ Insir Jlewe J[FC oz ) [es JPw  |luos IIE‘\

[Binary ] marg] [Elnaru [Binary | [Bunary | [EE]

1
n
1
] - : 0 o

) e | 1
s« END OF PPOGRAN www

If all the conditions are set to wait, the Instruction field will display
WAIT ALL. If all the conditions are set to continue, the Instruction field
will cisplay WAIT XXX, meaning any combinatlon will cause the pattern
geherator to continue

Caopy

( Pettern Gen & | ( Listing | | step I(Frint | ( Fun |

AR N | O | GED | CR | G | (N [y
l ' [Elnal‘g][ﬂlnarg HMJ lBlrlarg ”Bmuru ‘\ |E}

Ente

Delete

Merge i

sar STHPT OF PROGPHN +4s
[HRIT ALL ] oo
0T
K o i

A8

B

Copy

a .
Insert || **+ END DF FROGPAN +++

[
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WAIT IMB

The external wait inputs are sampled before the beginning of each data
output cycle If a Walt or Cont condltion is met from 30 ns to 0 ns
before the output data clock edge, the conditlon will be decoded
immediately and there is no latency. The wait or continue condition will
be active on the upceming output cycle.

If the input qualifiers do not meet the 0 ns to 30 ns set-up time, but
change after the positive clock edge, the conditton wili be active on the
next clock cycle.

If a Wait Instruction is placed in the first line of a program, the wait will
be at least two ¢ata cycles long

Menu: Listing
Field: Instruction (14)

Any module in the HP 16500A can slgnal the others through the
intermocdute Bus (IMB). This 1s particularly useful if you need one
module to tell another when to start

if the pattern generator encounters a WAIT EIMB instruction in the
program, it will hold the data outputs at their current state, while the
output data clock and the strobes continue to run  The pattern
generator will not continue to the next program line until it sees a
signal on the IMB. In other words, the pattern generator will wait untll
another module tells it to continue. This allows you to run part of a
pattern generator pregram and then walt for an event captured by
another module to occur before continuing,

Using Instructions
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The IMB can be armed only cnce per run of any given module  The
IMB signal is latched by a receiving module and is not reset until the
measurement is restarted Therefeore, it is not recommended that more
than one WAIT IMB instruction be used in a pattern generator
program. Since the IMB signal latch Is not cleared until a new run is
begun, multiple WAIT IMB instructions will resuft m the pattern
generator sampling a previously set condition  Any WAIT IMB
instruction after the first will thus be satisfied Immediately

As an example, suppose you have a logic analyzer card in the HP
165004 in addition to your pattern generator. You have the logic
analyzer "watching" for a service request from your system When the
Ingic analyzer sees the request, « can signal the pattern generator,
through the IMB, to rurt a program you have writteh that deals with the
interrupt. -

(Fetternen | {_Listing ) (srep J(Prnt ] (CP0 )

Label - mswr Jewr (e oz)lms (M I{ws_ J[uws |
l lBlrlurg-]lEhnurg \Lﬁlnerg]|BlnuruJLEmnrgJ@

l[’eme None HACROI
l Hergs I PEPEWT | HACPOZ

wne 5TRPT | HALT HACPOT

Base-

@ BREAK
|Insert +4% END OF|5IGHAL IMB




BREAK

Menu: Listing
Field: Instruction (14}

Another feature of the pattern generator is Its ability to run in single-
step mode (see Chapter 7, "Running and Stopping a Program”)  You
may run the pattern generator until you get to a particular section,
then single step the program The BREAK instruction allows you to
assume contral of the program for single-step operation  When you
ingert a BREAK instruction, the module will halt and wait for you o tell
It to resume fram the Step menu.  The Step menu 15 found in the
Listing menu.

l Pattern Gen A | (_ Listing J ( Step ][anf_J rF‘un )

Cavel+] [ nstr ek J[Fooiz]fas e jlups  JiLes |
l Bazex |'Binnrg]l_mnarg![Bmurg-llrﬂlrmrg] Binery |[Bing|

Hane HRCROI
| Nerge PEPEAT HACPO2

wws STAPT HATT HACFO®
e [ R DU T |
WAIT INE | HACFDA4 : ,

Copy ‘

H

Insert || **= ENU OF SIGHAL [HB

[

In Independent Run Single or Group Run Single, a BREAK instruction
halts all pattern generator output. Data, strobes, and the output data
clack will remam in the last state that occurred before the break.

In Repetitive Run Indepedent, a BREAK instruction will stop the
pattern generation output When the run control software detects that
pattern generation output has stopped, it will clear the break and run
the pattern generation program starting at the state immediately
following the break  This means that the grogram will halt only briefly,
untit the run control software detects the stop and can start the
program at the next state

Using Instructions
10-8



In Repetltive Run Group, the pattern generater will run until it
encounters a BREAK instruction, and will wait for the other modules
listed in the group run to complete therr measurements. The pattern
generator wilt then begin execution at the state Immediately Tollowing
the break When the pattern generator gets to the end of its program,
it will stap and wait for the other modules to complete their
measurements before continuing from line 0

For more information on independent and group run modes, see
Chapter 7 of this manual and the section entitied "Run Modes "

SIGNAL IMB

Using Instructions
1010

Menu: Listing
Field: Instruction {14)

The complement of the WAIT IMB is the SIGNAL IMB instruction.
When the pattern generator encounters a SIGNAL IMB instruction in a
program, it will output a signal to the Intermodule Bus (IMB). This
signal can be used Lo signal another module(s) to start running. The
signal can also be used to trigger another HP 16500A mainframe
through the IMB Qut port.

( Pettern Gen ﬁ] ( Listing | ( Steplenntl (_ Run ]
Leber-] [ Instr Jfcur NEEEEE Pk Jluns  JfLos
l Baze [B1narg llﬂlnurg_l Banory | [Binary ]LBlnurgllLﬁlna

l“E et | Hane HHCRO1
| Herge ‘ PEPEAT | MACROZ

wev STHPT WALT NRCRO3

HATT IHB

| Copy ] BREAK

The IMB signal is latched on the rising edge by the receiving module(s).
The latch is not cleared untill the start of a new measurement Because
of this, any SIGNAL IMB instruction after the first, will have no effect

HACROY




MACROS

on other modules that are monitoring the IMB. However, each SIGNAL
IMB instructlon can cause a signal to be sent out over the IMB Qut
port, by specifying it in the IMB menu.

Menu: Listing
Field: Instruction (14)

The instruction field lets you call macros Into your main program.  You
can define and ¢all up to four macros in a program If you have given
the macros specific names, those names will appear in the pop-up. if
you haven't renamed the macros, they will appear as MACROA,
MACRO2, MACRO3, and MACRO4 in the pop-up

[ Petrern Gen A | ( tisting ]  step T(Frint | ( rn )
‘Laber. | | Instr |{cur IS TR
l Biice: [Binery || Binary 'I[Emuru || B1nary | IB1inary ||EJ

'DEIELE ‘ Hane W J
| large I PEPEAT HACROZ

wie START | HAIT HACFDS
L u |

HWRIT INMB HACROA

") [N 1 .
|]ﬂ’39rl| +#»+ END OF|SIGNAL INB
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Te call a macro into your program, touch one of the macro fields from
the pop-up  The pop up will close and Lhe macro name will appear in
the Instruction field When the mamn program encounters the macro
cafl, t will start running the specified macro

Far more information on writing and using macros, see Chapter 6 of
this manual, "Creating and Using Macros.”

l Patfern Gen & ] ( Listing ‘1 L Step le'rlm | L Run J
anng]-J (nstr J(oe J(Fcos2)(as  Jlpm s }{ios |

Base- [EIHGIQJLBHIEFQJ [Blnurg HBlnarg JLEmuru \[E}

PEPEAT HHEPD2

vew START | HRIT HACPOS

AP q
RREMETEPY WazT 1na | neceoa

(e
"
e

SICNAL ING| -
#w+ END OF| J
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Setting Printer
Configuration

Printing Options

Using a Printer

All printer parameters are set in the System Configuration menu. [f you
have just connected your printer and are unsure of how to set the
configuration, refer to the HP 165004 Reference Manuai chapter
entitled "Connecting a Printer."

The HP 16500A supports HP-IB and selected RS-232C printers.

All the pictures in this manual were taken from an HP 16500A with cne
HP 16520A master card and one HP 16521A expansion card I the
screens on your instrument ciffer from the pictures in this manual, it
simply means that you have a different card configuration All other
functions will work the same except where noted

Menu: Any
Field: Print

All pattern generator menus include a Print field in the upper right of
the screen If you are in the Format menu and touch the Print field, a
pop-up fike the one shown below appears

[_ Peitern Gen A | | Formet J Fun

[ Input | Clock l Pe Cancel ]
T ‘ Internal an: lEgmbuls

l Poda

—_— « I Pod A3 Pad A Fod § Pruint Screen Pad B4
|Lahe\ ] I TTL TTL EETQCF DETHCHED
CLF

Fol P 07 7 [i]

FL 02
AS

R H
uos
LDS
arf
ofr
orr
ore
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There are two fields in the pop-up, Cancel and Print Screen

If you are i the Listing or any of the MAGRO List menus, a slightly
different pop-up will appear, like the one shown helow

s —_—
[ Fattern Gen A | l Listing | Lsrep | ' Run ]

Lenet| | tostr J{or Jfrc oiz)(es canel  f3 JiLOS |
Base: \Blnaru][ﬁmm"u | B1nei nary || Bina|

Print Screen

I Delete Frint w1l
| tlarge ‘
4wt START QF PPOGRAM #++

o |l IF&\ IIB:I::': [ A [ ][3
3 kN 0 1

u]

| Copy I

f—— o ' 1 ! 1

| Tnsert ‘ 4%+ END OF PROGPAM »»«

The pop-up contans three fields, Cancel, Print Screen, and Print All.

B =
(=4
(=3

Printing On- Menu: Any
Screen Data Field: Print

If you want a hardcopy record of the screen, touch the Print field and
then the Print Screen field front the pop-up  This will send a copy of
the screen to the printer in graphics mode

( Pattern Gen A | | Listing ] LSIEp \ -
lLuhwlL netr (oe (o 02 fns Cancel

P——
[ Binary ] [Binsry | [A1na

Base:

‘Delele‘
| Herge

L1L] STRFT aF f FH w4

0o \LI I B L
o 0
N : : ! .
. . .
| Cepy ! M : . . 0
—_— 1] " 1 : 1 1
Using a Printer l Inser,l wsr END OF PROGRAN ke
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Printing Entire
Program Lists

If you want to print part of a menu in graphics mode that is off screen,
you must roll the screen vertically or horizontally to place the part on
soreen  When the desired part is on screen, touch the Print Screen
Field

Menu: List, MACRO List
Field: Print

If you need a hardcopy record of an entire program or macro, touch
the Print field and then the Print All field from the pop-up  The Print All
field causes all the list and label data to be sent to the printer, but not

[ Faltarn Ger A _] l Listing ] LSM:ap ]
[Lanm | mnstr J{oee J(Froz (s Cancel s J{ios
Bass: Binary || Binary || Bined orint sereen 2T |Bina

e w

Merge

H

|

-
P

axs ST PROGRAH +=++
| [aco O 11 —_

Copy

i

o

Tneeri

i

(i} 0
i graphics mode like the Print Screen field. The data 1s sent in text
mode to speed printing of lang data lists  Print All prints the line in the
line number field and all those following. This lets you print from the
current line to the end of the program. If you want a hardcopy of the
entire program list, move line zero to the hne number field before
touchmng Print.

Using a Printer
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A Installing Pattern Generator Cards

Installation * You do not need to remove cards or filler panels that are below
Considerations where the pattern generator cards will go

* Only one intercard connecting cable 15 needed for any multiple card
configuration

® If other moduies in the mainframe prevent you from installing the
pattern generator according to the chart on following page, those
modules will need to be moved to other slots

* To maintain channel-to-channel skew and intercard signal fidelity, the
shortest intercard connecting cabkle should be used

® Expansion cards should be no more than two slots away from the
master card

Use the chart on the following page as a quide to selecting the correct
intercard connecting caple  The chart also shows where expansion
cards should be located in relation to the master card.

Installing Cards %EXJ?:&TE

PPV,
The effects of ELECTROSTATIC DISCHARGE can danlage
electromc components Use grounded wriststraps and mats
when performing the foilowing instaliation procedure

1 Turn the instrument power switch, Incated on the rear panel, to Off
Disconnect the power cord and any input ar autput connections

2 Starting from the top, lnosen the thumb screws on any filler panels
and cards already installed in the mainframe

Installing Pattern Generator Cards
A1



3 Starting from the top, begin pulling cards and filler panels out half

way.

TOP LARD

S=r

NEXT LOWEST
—-)

ey
CAUTION ¢
| caumon |

At mutti-card modules will be cabled together. Gare should
he taken to pull these cards out together.

WMASTER AND) EcPANS [ON CARD ORIENTATION

E eRANSION| EPANSTON
ENPANSION ExPANSTON E sPANSIOH ExPANSION EnPAMSION
WASTER | MASTER[ ] WASTER MASTER WSTER, MASTER HASTER
EnPANSICM ExFAdIION EWPANSTIN EPANSION E¥PANSION
EAPAKSION ExPANSION
‘;L’::I; woJ :E‘éN ;m;\.u‘r‘i hDJ:g;N;HzngE ADJEN:“;?UTS AL sLoTS
SL8T SELECTION 8520 EXOT

4 If you are installing only a pattern generator master card, it can be
installed in any avalable slot. If you are installing a master card and
expanston card{s), use the chart above to plan your card configuration

If you have a two card pattern-generator canfiguration, that 1s, one

master card and one expansicn, use the following intercard connector
cahle

installing Pattern Generator Cards
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If you have a three card pattern-generator configuration, that is, one
master card and two expansions, use the following intercard connector
cable.

If you have a four card pattern-generator configuration, that is, ong
master card and three expansions, use the following intercard
conhector gable.

if you have a {ive card pattern-generator configuratton, that is, one
master card and four expansicns, use the following intercard cornector
cable

e

Installing Pattern Generator Cards
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5 Insert the correct end of the intercard connector cable into the
connector on the bottom card of the configuration

CABLE & KEY
ON SAME SIDE

§ Lay the cahle of the intercard connector flat and pointing out to the
rear of the card

CONNECTOR

18520/EX09

7 Slide the bottom card approximately half way into the lowest slot
that you are going to use for the pattern generator

Installing Pattern Generator Cards
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8 Slide the next card half way inta the next highest slot, feeding the
intercard connector cable up through the hole in the card

9 Insert the intercard connector cable nto the connector on the card.

10 if you have more than two cards to install, repeat the previous two
sieps until you have all the cards i the mainframe

11 Push the hottom card all the way 1in and seat it into the backplane
cormector of the manframe  Keep applying presure to the center of
the card endplate while tightening the thumb screws finger tight,

12 Working your way up, push the rest of the cards in one at a time
and seat them into the bachplane connector

__1_\“_“_‘_—‘
K NEXT -
£ HIGHEST

.4 BOTTCM
: cARD

Any filler panels that are not used should be kept for future use Filler
panels must be installed i all unused card slots to maintain proper air
cireulation within the mainframe

If adding expansion cards to an already installed set, you'll need to pull
all the instafled pattern generator cards completely out of the
mainframe Rermove the intercard connector cable, and use one that
will connect all the cards (installed and new) with one cable. Then
foliow steps 5 through 12 to renstall all the cards

Instaliing Pattern Generator Cards
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B Specifications

and Characteristics

Specifications

Clock Sources  Intemal Clock
(HP 16520A Only) Clock Period
Data Period Accuracy
External Glock

{provided by user)
Input Clock Perlod

Duty Cycle

piogrammable from 20 ns lo 200 s in a
one-two-flve sequence

+ 2% {of penadi 21 ne

1 Hz 1o 5¢ MHz {20 ns min perfod) EGL o TTL,
internal ftequency divide (1, /5, ar j10) provided

10 ns mimmum high time
10 ns mimmum lew Hime

Strobes  Number of Strobes
(HP 16520A Only)
Bits/Channel

Maximum Bit Rate

Edge Placement

Minlmum Delay

Minimum Width

J(ECLor TTL)
4095
20 MBiLfs |50 ns period)

< 10 MBitts lenths ol pericd > 10 MBit/< to 20
MBils/s Nilths of petiod (DELAY + WIDTH £
PERIOD)

0/10 10/5), ma=imum delay Is 9/10 {4/5) rlata
period

1710 (1/5) of data petlod, mawimurn width is the
data peuod (values in parentheses apply to 10
MBIt/s imbase sefting) [f shobes are deshed
while opetatmg wilh external clock, the data rate
will be dividled] Lo 1/5 or 1/10 the external clock
rate

Speciications and Characteristics
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Characteristics Eight channel pods can be assigned as elther standard ECL or TTL levels Al
characterlstics are valid at the probe tip
Qutput ECL TTL
VoH (steady state) IR 27V
VoL {steady state) 155 Y 06V

Risetime/
falttime (1yp)

Channel-1o-
channel skew*
(same card)

Channel-to-
channel skew*

(card-to-card)

Number of std loads

into 10k£}, 10 pF)

23ns
{-098 ¥V to -1 55V}

£5ns

< 10 ns

310 KH ECL,
@ Ynh = 150 mv)

{into 10 kL2, 10 pF)

25ms
0BV Iio27vV)

£5 ns

<10 ns

3(LS,

@ Vi = 250 mv)

{Output measurements made into a load conststing of 10 k& In setles shunted with

10 pF to ground.)

{*) Skew meastured at [+1 6 V) TTL and (-1 3 V) ECL levels

Data Capacity

Number of channels

Bits per channel

Maximum bit rate

Specifications ancd Characlerislics

B-2

165204
12

4095

50 MBit)s MRZ
(20 ns penod)

165214
45

4095

50 MBit/s NRZ
{20 ns petlod)



Input

Vih {min)

Vi {max)

Maximum input voltage
Inpul impedance

Exteral clock-in io
clock-out delay

ECL TTL
a9ty 20BY
169V 112y

tao v
100 kQ, & pF
50 ns

Editing Functions

Program Listing

DELETE, MERGE, COPY, INSERT

Listing Bases

Blnary, oclal, decimal, hexadecimal, and symbol

Step Mode

Single-step program execution in 1 o 999
piagram line steps, flom a break.

Data Instruction
Set

Break

Repeat
Wait IMB

Wait External

Signal IMB

Macro

Stope program exgcution, last data vector is held
al output

Repeals vector up fo 256 times

Walt for Intetmedule trigger

Walt for user-defined 3-bit patern an external
Input pod to become trtue. Mo data cycle latency
when pattetn Is true between 30 ns and 0 ns
before next cloch edge

Arms olher measurement cards.

Four diffetent mactos may be deflned and

inserted as needed. A slx character name may
be delined for each macro  Macros may contain

Specifications and Characteristics
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AEPEAT, WAIT EXTERNMAL, WAIT IMB, BREAK
AND 3IGHMAL MB instructions

Operating
Environment

Temperature

Humidity
Altitude
Vibration

Operating

Mon-operating

Specifications and Characteristics

B-4

Instrument, 0% 1o 55° C{+32° w1317 F)
Frobe lead sets and cables, 07 to 65° € (+32°
to 140 Fy

Instrument, up to 85% retative humidity at 40° C
(104° Fy

To 4600 m (15,000 ).

Random vibration 9-500 Hz, 10 minutes per axls,
“02giims)

Random vibralion 5-500 Hz, 10 minutes per axis,
~2 41 g {tms}), and swept sine resonant search,
5500 Hz, 0 7% g (0-peak), 5 minute resonant
dwell (@ 4 resonances per axls



Index

This index covers the HP 165204 /165214 Reference Manual It does not cover the Getting Started
Guide. Sequences of pages are represented with a slash (for example, 6-8/6-17)

A

Adapter pod, 2-1

Assignment
strobes, 9-2/9-4
data channels, 4-7

Autorall, 5-14/5-16

BREAK, 7-4/7-5,10-9/10-10

C

Cables 2-1
replacing 2-10
Channel
grouping, 4-1
naming, 4-3
numbering, 4-6
output, 4.7
CLEAR, 1-5
Clock
external, 2.3,4-11/4-12 9-10
internal, 4-10/4-11
period, 4-10/4-12
Color coding
cables, 2-3
probes, 2-4

Golumn order, 5-4/5-5
Connecting
ECL output, 2-8,2-9
probe adapter, 2-2
probes, 2-5
TTL output, 2-8,2-9
Cont, 10-7
Copying lines, 5-10/5-11
Greating a symbol table, 8-1
Cursor, 3-6

D

Data channels, 1-1
assigning, 4-7
disabling, 4-8
enabling, 4-7
naming, 4-3

Data entry field, 3-6

Cata rate, 1-1,3-2,4-104-11

Data entry field, 3-6

Delay. strobe, 9-6/9-9

Deleting
ines, 5-8/5-9
symbols. 8-10

Disabling output
data, 4-8
strobe, 9-2,9-19-12

Dise, 5-13

Display base, 5-3

index
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Displaying symbols, 8-11/8-13
Divide by, 4-129.10/3-12
DONE, 3-6

E

ECL connectors, 2-8,4-6

EGL input, 4-14

Editing output patterns, 5-1

Enabling channels
data, 4-7
strobe, 9-2

External clock, 4-10,4-11
period, 4-12

External input
connecting, 2-10
signal type, 4-14
threshold, 4-14

F

File name, 5-13
First State, 7-5
Format

fieid, 3-5

menu, 3-5.4-1

menu index, 4-2
Front-panel knob, 3-1

Index.
format menu, 4-2
hsting menu, 5-2
macro menu, §-2

input qualifiers, 4-14,4-15

Index
I-2

Inserting lines, 5-8

Instruction field, 101

Internal clock,
pertod, 4-10/4-12

K

Knob, 3-1,3-64-5

L

Labels, 2-1

cable, 2-3

default, 4-3

modifying, 4-4

probe, 2-4

reading, 5-4

turning off, 44

turnineg on, 4-3
Label> Base>, b-45-6
Lines, moving, 5-13/5-14
Line numbers, §-5/5-6
Listing

fields, 5-1

menu, 4-10,5-1,5-4 8-8

menu index, 3-2

M

MACRO, 10-11/10/12
Macro
cailing, 6-7
definition, 6-3
editing, 6-8
example, 6-9
instruction, 10.11/10-12



Macro {continued)
menu, 6-1
menu index, §-2
naming, 6-3
Malnframe, 3-4
Merging lines, 5-12/5-14
Module, 3-2,3-4
meanus, 3-3
Mouse, 3-1,3-7
Moving lines, 5-13/5-14
Moving screen
horizontally, 4-13/4-14,5-17
vertically, 4-12/4-13,5-13/5-14

N

New Symbol, 8-2,8-3
None, 10-2
Numerical hase
data, 5-3
symbol, 8-8

o

Qutput channgls
assighing, 4-7/4-99-2/9-1
¢hsabled, 4-4.4-8
Output pattern, entering, 5-7
Qutput palarity, 4-9 9-4/9-6

P

Parameters
fields, 6-4
macro, 6-6

PARAM1, 6-4,6-5

PARAMZ2, 6-4.6-5
Pattern data
entering 3-4
menus, 3-5
values, 4-1
Pattern generator process, 1-2
Polarity
data channel, 4-9
strobe channel, 9-4/9-8
Pod
grouping, 2-7
numbering, 4-6
Power up, 3-1
Printing
cancel, 11-2
lsts, 11-3
options, 11-1
screens, 11-2
Probes, 1-1,2-1/2-2
adapter pods, 2-1,2-2
conhecting, 2-5
data, 2-1,2-11
grabbers, 2-5
input qualfier, 2.5
labal, 2-1,2-4
leads, 2-10/2-11
remaving, 2-10
signal, 2-5
tips, 24
Program steps, 1-1

R

Range, symbaol value, 8-5/8-7
REPEAT, 10-2/10-3

Repetitive run, group, 9-11
Repebitive run, independent, 9-11
Resume, 7-6

Index
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Rolling screen
horizontally, 4-13,5-17
vertically, 4-12,5-6
Run modes,7-1,10-9
group single, 7-1,10-9
group repetitive, 7-1,10-9
independent single, 7-19-12/9-13,10-8
independent repetitive, 7-1,10-9
Running repetitively, 7-3,9-12/9-1310-9
Running single, 7-2,9-12/9-13.10-9
Running single-step, 7-4/7-7,10-9

S

Signal
ground, 2-1,2-2,2-7
leads, 2-2,2-5,2-6,2-7
SIGNAL IMB, 10-10
Single run, independent, 9-11
Single runh, group, 9-11
Start address, 8-6
Step run, 7-447-7
Step count, 7-5
Stop, 7-7/7-8
Strobe
assigning, 9-2/9-4
channel 1-1
definition, 9-1/9-3
delay, 9-6/9-9
external clock, 9-10/9-12
polarity, 9-4/9-6
width, 9-6/9-9
Symbaol
adding, 8-9/8-10
definition, 8-1
deleting, 8-9/8-10
display, 8-11/8-13

Index

Symbol {continued)
entering, 8-1,8-2
leaving, 8-11
mndIfylng 8-9/8-10
name, 8-2
selection, B-7
table, 8-1
width, 8-8/8-9

System, 3-23,3-3
power up, 3-1

T

Touch screen, 3-13-2
TTL
connectars, 2-8,4-G
Input type, 4-14

U

User-defined, 4-14
User interface 3-1
devices, 3-1

V'

Value range, 8-5

w

WAIT, 4-15,10-3/10-7
WAIT ALL, 10-6

Wait External, 10-5/10-6
WAIT IMe, 10-7/10/8



Worldwide Sales
and Support

DIRECTORY

Hewlett-Packard products are sold and supported worldwide through

HP offices.

® Tb contact one of the more than 240 HP Sales and Service Offices
worldwide, check your telephone directory or contact one of the

major HP offices listed.

Argentina
B Martinez
Phone: 798-6086

B Australia
North Ryde, N.SW
Phone: 02/887-1611

H Blackburn, Victoria
Phone 03/880-6351

Austria
# Vienna
Phone: 22:3/3616210

Belgium
@ Brussels
FPhone: 02/762-3200

Brazil
B Alphaville, Baruer1
Phone: 011/421-1311

Canada
B Edmonton, Alberta
Phene: 403/452-3670

B Richmond, British
Columbia
Phone: 644/270-2277

Mississauga, Ontario
Phone 416/678-9430

Denmark
Birkeroed
Phone: 2/81-68-10

Finland
Espoo
Phone 90/455 0211

Jyvaskvla
Phone- 41/216318

Oulu
Phone BLi338785

France
Les Ulis
Phone: 1/9077825

Hong Kong
Wanchai
Phone: 5/832-3211

Italy
Cernusco Sul Naviglio
Phene: 2/203691

Japan
Yokogawa-Hewlett
Packard

COsaka
Phone: 6/304-6021

Sagumihara
Phone: 427/58-1311

Tokyo
Phone: 3/331-6111

Malaysia
Kuala Lumpur
Phone: 03/943-022

Mexico
Xochimilco, Mexico City
Phone: 905/676-8895

The Netherlands
Amstelveen
Phone: 0200472021

New Zealand
Pekuranga
Phone $/6B-7159

B Full Field Repaiwr Center capabilities



Norway
B QOesteraas
Phone: 2/17-11-80

Puerto Rico
Carolina
Phone: 809/762.725

Saudi Arabia

W HPF TNistributor,
Modern Electronics
Riyadh
Phone: QL/M919715

Singapore
W Singapore
Phone: 631788

South Africa
B Sandton, Tranzvaal
Phone; 11/802-511

Spain
B Mirasierra, Madrid
Phone: 91/734-1162

Sweden
B Spanga
Phone: 8/750-2000

Switzerland
Widen
Phone: 57/31-21.11

Taiwan
Taipei
Phone: 2/712.0404

United Kingdom
Altrincham
Phone 61/928-6422

Winnersh, Wokingham
Phone 734/784-774

United States
Santa Clara, Califorma
Phone 108/988-7000

Los Angelea, California
Phone 213/970-7500

Englewood, Colarado
Phone 303/771-3455

Atlanta, Georgia
Phone 404/955-1600

Rulling Meadows, Illinois
Phone 312/255-9800

Rockville, Maryland
Phone: 301/948-6371)

Andover, Massachusetts
Phone: 617/861-3960

Nowv1, Michigan
Phone: 313/3-19-9200

Paramus, New Jersey
Phone: 201/265-5000

King of Prussia,
Pennsylvama
Phone: 215/265-7000

Richardson, Texas
Phone 214/231-6101

Bellevue, Washington
Phone: 206/643-4000

Venezuela
Caracus
Phone: 2/239-4133

West Germany
Boeblingen
Phone: 7031/667750

B Full field Repair Center capabulities.

Other European Locations
For information on European locations other than those listed, contact:

Hewlett-Packard, S.A.
150, Route du Nant-d'Avril

PO. Box
1217 Meyrin 2

Geneva, Switzerland

Other International Locations
For information on locations outside the U.S. and Europe that are not

listed, contact:

Hewlett-Packard Intercontinental

3495 Deer Creek Road
Palo Alto, CA 94304 USA.





